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Abstract 
Prostate cancer (PCa) is the most diagnosed cancer in men and it is the second leading cause of 

cancer-related death in Western societies. Despite improved treatments for metastatic prostate 

cancer patients, not all patients respond similarly thereby affecting overall survival. To reduce the 

frequent administration and ineffectiveness of treatments, there is a need for prognostic markers 

which can help predict the response of patients to therapies, making treatments more targeted 

and personalized.  

In this study, we aimed to develop a realistic model to study the phenotypic response of PCa cell 

lines, towards androgen stimulation and inhibition. We performed a proteomic analysis (PSA 

secretion) of multiple PCa cell lines (LNCaP, PC-3, 22Rv1, RWPE-1, RWPE-2 and PWR-1E, EMC-

PCa-41 organoid cells) derived from different stages of PCa, in response to androgen stimulation 

(R1881) and inhibition (Enzalutamide).  We detected PSA secretion from different malignant PCa 

cell lines (LNCaP, 22Rv1, EMC-PCa-41) and observed absence of PSA secretion in the benign 

cell lines. This is confirmed with ELISA. In addition, PSA secretion from single LNCaP cells was 

identified and we observed that the PSA secretion of LNCaP cells is affected by the anti-androgen 

Enzalutamide. These results suggest that LNCaP cells can be used as a model mimicking the 

responses to anti-androgens in mHSPC patients. 

However, this method fails to distinguish between PSA secretion from low-producing cell lines and 

artifacts. To overcome this, a microwell chip is recommended and more optimization on the 

quantification method must be done. 

The PCa cell lines (LNCaP, PC-3, 22Rv1, RWPE-1, RWPE-2 and PWR-1E) were also 

phenotypically characterized using immunofluorescence staining (PSA, PSMA) and flow 

cytometry (PSMA, EpCAM, HER2). Our findings indicate PSMA, EpCAM, and HER2 expression 

in malignant PCa cell lines and the absence of PSMA expression in the benign cell lines. In 

addition, the hormone-sensitive LNCaP cell line shows higher levels of PSMA and HER2 

expression compared to the benign and the castration-resistant cell lines. 

Proteomic analysis of single cells can help identify prognostic biomarkers and develop an effective 

and personalised therapy for PCa patients. Using a PVDF membrane, LNCaP cells can serve as 

a good model to study the PSA secretion in response to drugs. In the future, a microwell chip can 

help to identify the effect of drugs and stimulation on PSA secretion from the other PCa cell lines.  
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1. Introduction 

1.1 Prevalence and diagnosis of prostate cancer 
Prostate cancer (PCa) is the most diagnosed cancer in men and it is the second leading cause of 

cancer-related death in Western societies (Siegel, Miller, & Jemal, 2020). In the Netherlands 

alone, more than 12.000 men are diagnosed each year with PCa (IKNL, 2021).  

In order to detect PCa, common screening procedures, like Digital Rectal Examination (DRE) or 

blood Prostate Specific Antigen (PSA) test are used. By performing DRE the doctor can feel 

abnormalities of the prostate. This does not confirm the presence of PCa and is therefore mostly 

used as an additional test to the PSA test. This PSA test is a non-invasive test in which blood is 

drawn to check PSA levels. Elevated PSA levels (≥ 4 ng/mL) could indicate PCa (Tikkinen et al., 

2018)(Catalona, 2018). However, the elevated PSA levels could also be caused by other factors 

such as the age of the men or prostate inflammation (Tikkinen et al., 2018). To determine the 

reason for the elevated PSA levels, men can undergo an MRI scan and biopsy. By performing an 

MRI scan abnormalities around the prostate can be detected. Furthermore, an MRI scan can 

determine whether cancer has spread to other places in the body. With a biopsy, a small sample 

of tissue is taken from the prostate. This tissue sample is examined by histology and the biopsy 

results determine the aggressiveness of the tumor (Tikkinen et al., 2018)(Duffy, 2020). To monitor 

the tumor regression after treatment, blood PSA levels are evaluated and MRI scans are taken.  

Of the diagnosed PCa patients, around 70% have localized prostate cancer (IKNL, 2021). The 

overall survival (OS) for patients with localised prostate cancer is very high, the relative 5-year 

survival rate is almost 100% (The American Cancer Society, 2020)(IKNL, 2021)(Ng, Smith, & 

Shamash, 2020). Therapies such as surgery or radiotherapy are in most cases successful in 

removing the localized tumor for these PCa patients.  

 

1.2 PCa progression and metastasis 
Despite receiving these treatments, some PCa patients experience biochemical recurrence (with 

increased PSA levels), without metastasis in distant regions leading to non-metastatic Hormone-

Sensitive Prostate cancer (nmHSPC) (Figure 1, (Dathathri et al., 2022)). Patients can be 

Figure 1: Disease states of PCa. PCa begins with localized PCa. This tumor is in most cases successfully removed using 
radiation or surgery. However, some patients are diagnosed again with increased PSA levels, this is referred to as (m)HSPC. 
The main therapy is ADT. However, overtime (m)HSPC patients can develop resistance to ADT. This is referred to as (m)CRPC. 
There is no curative treatment for this stage. However, to reduce cancer progression and symptoms mCRPC is treated with a 
combination of ARSi, Radium-223 and chemotherapy. (Dathathri et al., 2022) 
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diagnosed with metastasis in distant regions of the body, mainly bone, lymph nodes, liver and 

lungs, leading to metastatic Hormone-Sensitive Prostate Cancer (mHSPC). In both nmHSPC and 

mHSPC patients, the main therapy administered is androgen deprivation therapy (ADT), which 

helps to reduce androgen levels and thus inhibits tumor growth (Perlmutter & Lepor, 2007). ADT 

can be combined with androgen receptor signalling inhibitors (ARSi) and/or chemotherapy to treat 

mHSPC patients. However, over time, (m)HSPC can develop resistance to ADT and lead to 

(metastatic) Castration-Resistant Prostate Cancer ((m)CRPC), which is the end stage of the 

disease. Around 10-20% of the patients progress to this advanced disease stage (Vellky & Ricke, 

2020)(Wade & Kyprianou, 2018). A curative treatment does not exist. However, to slow down the 

cancer progression, prolong survival and reduce symptoms, mCRPC is commonly treated with a 

combination of hormone therapy (ARSi), radiotherapy (radium-223) and chemotherapy (e.g. 

docetaxel) (Ng et al., 2020)(Wade & Kyprianou, 2018). 

 

Despite the emergence of novel treatments for mHSPC and MCRPC, some patients do not 

respond to therapy and show poor OS, thereby rendering the treatment ineffective. There is a 

need for biomarkers to help in identifying, stratifying and monitoring patients who show poor OS, 

and to predict treatment. PSA is the most widely used biomarker for PCa. Biomarkers also provide 

the advantage of being less invasive compared to a tissue biopsy or MRI scan. In the next chapter, 

various potential biomarkers which can improve prognosis and help in developing personalized 

treatment will be discussed.  

 

1.3 Biomarkers 
Biomarkers are indicators of a medical state which can be measured accurately (Strimbu & 

Tavel, 2010). There exist a broad scale of different biomarker types. A few examples are blood 

biomarkers, lipids, extracellular vesicles (EVs) with their constituents, or circular tumor cells 

(CTCs). Overexpression or lack of certain biomarkers could have a diagnostic, predictive or 

prognostic value. In this chapter, PSA, PSMA, EpCAM and HER2 are discussed. PSA is a blood 

biomarker, a protein which is secreted by cells. PSMA, EpCAM and HER2 are all glycoproteins 

on the cell membrane. 

1.3.1 Prostate Specific Antigen 

PSA is a protein which is secreted by healthy as well as cancerous epithelial cells of the prostate 

gland and encoded by the KLK3 gene. PSA is present in the semen and blood of men with healthy 

prostates and is often elevated in men with prostate cancer, other prostate diseases or 

inflammation (Tikkinen et al., 2018). 

PSA is the current gold-standard biomarker for screening, diagnosis and prognosis of PCa (Tonry, 

Finn, Armstrong, & Pennington, 2020). Testing the PSA levels in the blood of men is non-invasive 

and men with PSA levels ≥ 4 ng/mL are recommended for biopsy or MRI scan to find out whether 

the elevated levels are caused by PCa (Tikkinen et al., 2018)(Catalona, 2018).   

 

However, there are some limitations to using PSA as a biomarker for PCa as well. Using PSA as 

a screening biomarker contributes to over-treatment. For only 33% of the men with raised PSA 

levels, a diagnosis with PCa is given. For this, an additional biopsy or performing an MRI scan is 

necessary (Tikkinen et al., 2018)(Catalona, 2018). This indicates that there are many men with 

elevated PSA levels who do not have PCa (false positive)(Tikkinen et al., 2018). Screening for 

elevated PSA levels can also lead to the detection of many low-risk tumors, many of which cases 

never cause significant harm to a patient and do not require treatment (Tonry et al., 2020). 

Furthermore, with PSA as a screening strategy for PCa, not all PCa cases will be found and false 
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negatives can be missed. Despite low PSA levels (≤ 4 ng/mL), around 15-20% of the men with 

low PSA levels have an aggressive form of PCa (Tikkinen et al., 2018)(Carm et al., 2019). These 

patients will not show up on the PSA blood level test. 

Another limitation of PSA is that it is not able to differentiate between localized and aggressive 

metastatic forms of cancer and identify the heterogeneity in patient prognosis (Duffy, 

2020)(Terada et al., 2017).  

Despite these limitations, PSA remains the best validated and most prognostic biomarker for OS 

in metastatic Prostate Cancer (mPCa). C. Harshman et al. concluded that a PSA level ≤ 0.2 ng/mL 

at 7 months is prognostic for longer OS of mHSPC patients on ADT (Harshman et al., 2018). This 

seems promising. In the future, PSA should be combined with other biomarkers for determining 

tumour aggressiveness and predicting outcomes (Duffy, 2020).  

 

1.3.2 Prostate-Specific Membrane Antigen 

Prostate-Specific Membrane Antigen (PSMA) is a membrane protein and is expressed in all types 

of prostate tissue and often increased in prostate tumor cells and tumor tissue (Chang, 

2004)(Chang, Reuter, Heston, & Gaudin, 2001). A new imaging technique is being explored for 

early detection of PCa metastasis or biochemical recurrence, called PSMA positron emission 

tomography (PET) (Donswijk et al., 2020)(Tsechelidis & Vrachimis, 2022). 68Ga-PSMA-11 is a 

radioactive imaging agent which binds to PSMA when it is injected into the patient. Due to 

overexpression of PSMA on cancerous tissues, PCa cells are localized and can be imaged using 

PET, which helps to indicate metastasis (Tsechelidis & Vrachimis, 2022). However, one of the 

limitations of this technique is that PSMA is not expressed in all prostate tumors. Additionally, PCa 

shows intra- and interpatient heterogeneity of PSMA expression (22). Further studies are needed 

to evaluate the diagnostic and therapeutic value of PSMA as a PCa biomarker. 
 

1.3.3 Epithelial cell adhesion molecule 

Epithelial cell adhesion molecule (EpCAM) is a transmembrane glycoprotein, which is commonly 

used to capture circulating tumor cells (CTCs) in the blood of cancer patients (Keller, Werner, & 

Pantel, 2019). In multiple carcinomas, including prostate cancer tissue, EpCAM is often 

overexpressed (Massoner et al., 2014)(Keller et al., 2019)(Ni et al., 2012a)(Ni et al., 2012b)(Liao, 

Wu, Jia, Mou, & Li, 2022). Research is done into EpCAM as a potential prognostic biomarker. Y. 

Liao et all discovered a close association between high EpCAM expression and poor PCa 

prognosis (Liao et al., 2022). In addition, due to overexpression of EpCAM in PCa, it is a promising 

target for PCa treatments. This is the most optimal in combination with targeting other pathways, 

based on individual tumor profiles (Ni et al., 2012b). More data is required to establish EpCAM as 

a prognostic biomarker or a potential EpCAM targeted therapy for PCa. 

 

1.3.4 Human epidermal growth factor receptor 2 

Human epidermal growth factor receptor 2 (HER2) is an important prognostic biomarker in breast 

cancer. Breast cancer patients with overexpression of HER2 are called asHER2-positive. These 

patients can be treated with HER2-targeted therapies (Dent, Oyan, Honig, Mano, & Howell, 

2013)(LI & LI, 2013). HER2 also drives the progression of other cancer types. However, the role 

of HER2 in the progression of PCa is poorly understood. Previous studies show contradicted 

results when studying the expression of HER2 in PCa. Immunohistochemical (IHC) analysis 

reported HER2 expression rates ranging from 0% to 100% (Day et al., 2017)(Sharifi et al., 2016). 

However, K.C. Day et al., and N. Sharifi et al., discovered both increased HER2 protein levels in 

PCa patients (Day et al., 2017)(Sharifi et al., 2016). Further studies are needed to evaluate the 

potential of HER2 as a PCa biomarker. 

Met opmerkingen [PY(SMB1]: Mention the cell search 
system which employs epcam based enrichment to improve 
detection of CTCs. 
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1.4 Therapies 
As described previously, each stage of PCa is treated with different therapies. Localized PCa is 

usually treated with surgery or radiotherapy. In most cases this is very successful, the relative 

survival rate is almost 100%. This is in contrast to patients with mPCa. The OS rate for mPCa is 

around 30% (The American Cancer Society, 2020)(Dathathri et al., 2022). An improved outcome 

for these patients is crucial. mHSPC is usually treated with ADT and increasingly ADT is combined 

with ARSI or chemotherapy, as explained in this chapter. 

 

1.4.1 Role of androgens in PCa 

Prostate cancer is driven by androgens. Androgens are steroid hormones, such as testosterone. 

Testosterone is enzymatically converted into dihydrotestosterone (DHT) when it enters a cell, see 

Figure 2. DHT binds to the androgen receptor (AR) which results in dimerization and nuclear 

translocation of the AR. This is followed by binding to specific DNA sequences, androgen response 

elements (ARE), which increases the transcriptional activity of androgen-regulated genes, such 

as PSA,  and promotion of prostate epithelial proliferation (Wade & Kyprianou, 2018)(Girling, 

Whitaker, Mills, & Neal, 2007). PCa progression is regulated by androgens through this pathway. 

Therefore, many therapies are based on targeting the AR. In 1941, Dr Huggins et al. demonstrated 

for the first time a relationship between androgen depletion and a reduction in clinical symptoms 

(Huggins, 1942)(Narayanan, 2020). 

 

 

 

 

 

 

 

 

 

 

 

 

 

Initially, the reduction of androgen levels causes tumor regression. However, when PSA levels 

increase despite low testosterone levels, PCa is classified as CRPC. The AR remains the driver in 

CRPC. However, the AR can adapt itself to the new environment so it does not require high 

androgen levels. Mechanisms are for example AR overexpression, in which the AR becomes 

hypersensitive to low levels of androgens. Or an AR mutation, which results in higher AR activity 

by a broad spectrum of hormones (Narayanan, 2020). As a result of these mechanisms, therapies 

to reduce androgen levels will fail to suppress CRPC (Chandrasekar, Yang, Gao, & Evans, 2015) 

Figure 2: Schematic overview of the pathway of the androgen receptor (AR). Testosterone enters a 
cell and is converted into dihydrotestosterone (DHT). DHT binds to the AR and the AR translocates to 
the nucleus. This results in transcriptional activity, with cell growth, cell survival and protein 
synthesis as consequence. 
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1.4.2 Androgen deprivation therapy 

ADT is focused on reducing the levels of these androgens to prevent PCa cells from growing. 

Different types of ADT can be used. The most common way of ADT is by injecting drugs that lower 

the amount of testosterone. Another type of ADT is surgical castration. In this process, the testes, 

where androgens are produced, are surgically removed (Perlmutter & Lepor, 2007). A major 

disadvantage of ADT is that (m)HSPC can develop resistance to ADT over time. This results in 

(m)CRPC. To prevent this, more research is being conducted on the addition of chemotherapy or 

ARSIs to ADT (Dathathri et al., 2022). 

 

1.4.3 Androgen receptor signalling inhibitors 

ARSIs are novel hormone therapies, which use abiraterone and anti-androgens, such as 

enzalutamide and apalutamide (Mitsiades & Kaochar, 2021). Abiraterone targets CYP17. CYP17 

is an enzyme which is involved in the synthesis of androgens. Abiraterone inhibits the enzymatic 

activities of CYP17. Enzalutamide and apalutamide are second generation anti-androgens. They 

both bind to the ligand-binding domain of AR, which prevents AR nuclear translocation and thus 

the production of androgenic proteins (Mitsiades & Kaochar, 2021)(De Velasco et al., 2021).  

The addition of ARSIs and/or chemotherapy to ADT resulted in improved OS for most patients  

(Dathathri et al., 2022)(Wenzel et al., 2021). 

Despite improved treatments for metastatic prostate cancer patients, not all patients respond 

similarly thereby affecting overall survival. The ineffectiveness of treatments for metastatic prostate 

cancer is attributed to the heterogeneity seen in the tumor of patients (Dathathri et al., 2022). To 

reduce the frequent administration and ineffectiveness of treatments, there is a need for 

prognostic markers which can help predict the response of patients to therapies, making 

treatments more targeted and personalized. 

 

 

 

  



9 
 

1.5 Aim 
In this study, we aim to develop a realistic model to study the phenotypic response of PCa cell 

lines, towards androgen stimulation and inhibition of AR. This study will give more insight into the 

characteristics of different PCa cell lines, derived from different stages. These PCa cell lines can 

be used as models in further studies and to predict the response to treatments.   

The secretion of prostate-specific antigen (PSA) was used as a read-out of the phenotypic 

response and validated with the identification of cellular PSA. Additionally, the expression of other 

biomarkers like PSMA, EPCAM and HER2 were evaluated. 

To achieve this goal, the following  objectives were set:  

- Proteomic analysis (PSA secretion) of multiple PCa cell lines (LNCaP, PC-3, 22Rv1, 

RWPE-1, RWPE-2 and PWR-1E) derived from different stages of PCa, in response to 

androgen stimulation (R1881) and AR signalling inhibitor (Enzalutamide) 

- Optimization of the quantification of PSA secretion on PDVF membranes 

- Phenotypic characterization PCa cell lines (LNCaP, PC-3, 22Rv1, RWPE-1, RWPE-2 and 

PWR-1E) 

- Culturing CTC-derived organoids from an mCRPC patient (EMC-Pca-41) and evaluating 

the PSA secretion 
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2 Materials and method 
To achieve the objectives, various experiments were performed. An overview of all experiments 

which were performed in this project, is illustrated in Figure 3. 

  

Figure 3: Methodological overview of all experiments. Created by biorender.com. 
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2.2 Cell lines 
Different PCa cell lines derived from different stages were cultured in this project. More information 

about these cell lines is presented in Table 1. HEPG2 was used as a negative control cell line. The 

cell lines which are used (PWR-E1, RWPE-1, RWPE-2, LNCaP, 22Rv1, PC-3 and HEPG2) were 

obtained from American Tissue Culture Collection (ATCC,  USA).  

Table 1: An overview of the properties of different prostate cancer cell lines. 

Cell line Source Metastasis PSA secretion Cellular PSA  

Benign (Be) 

PWR-E1 Epithelial No No (Deep, 

Oberlies, Kroll, & 

Agarwal, 2008) 

Yes (Deep et 

al., 2008) 

RWPE-1 Epithelial No No (Sasaki et al., 

2016) 

Yes, when 

exposed to 

R1881 (Bello, 

Webber, 

Kleinman, 

Wartinger, & 

Rhim, 1997) 

Hormone-sensitive (HS) 

RWPE-2 Epithelial No - Yes, when 

exposed to 

R1881 (Bello et 

al., 1997) 

LNCaP Epithelial 

(lymph node) 

Bone 

metastasis 

Yes(Sasaki et al., 

2016)(Yamamoto 

et al., 2020)(Deep 

et al., 2008) 

Yes (Deep et 

al., 2008) 

Castration-resistant (CS) 

22Rv1 Epithelial Bone 

metastasis 

Yes(Sasaki et al., 

2016)(Attardi, 

Burgenson, Hild, & 

Reel, 2004)(Deep 

et al., 2008) 

Yes (Jemaa, 

Sallami, 

Céraline, & 

Oueslati, 2013) 

PC-3 Epithelial 

(vertebral) 

Bone 

metastasis 

No(Yamamoto et 

al., 2020)(Tai et 

al., 2011) 

No (Tai et al., 

2011) 

 

The cells were maintained at 37°C in an atmosphere containing 5% CO2. The components of the 

cell culture medium are listed in Tables 2, 3 and 4.  

The cells in T25 treated culture flasks (VWR international B.V., Amsterdam, The Netherlands) were 

harvested when they reached 70% confluency. RWPE-1, RWPE-2, and PWR-E1 were washed 
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with Dulbecco's phosphate-buffered saline (DPBS) (Lonza, Verviers, Belgium). Prewarmed diluted 

0.05% trypsin-EDTA (Gibco, ThermoFisher Scientific, Waltham, USA)  with DPBS [1:1] was added 

and incubated for at least two minutes. Cells were collected in DPBS + 2% Fetal Bovine Serum 

(FBS) (Sigma Aldrich, St. Louis, USA) to deactivate the trypsin. The desired cell concentration 

was added to a new tissue culture flask with fresh cell culture medium. All three cell lines were 

seeded with a seeding density of 5.000 cells/cm2. 

LNCaP, PC-3 and 22RV1 cells were washed with phosphate-buffered saline (PBS) (Sigma Aldrich, 

St. Louis, USA). Prewarmed 0.05% trypsin-EDTA was added and incubated for 1 minute at 37⁰C. 

When cells were detached, the cells were collected in fresh medium with pipetting and counted 

using the Luna-FLTM automated cell counter (Westburg B.V., Leusden, The Netherlands). The cells 

were passaged into new flasks and maintained in a humidified incubator at 37°C and 5% CO2.  

LNCaP cells were passaged with a seeding density of 10.000 cells/cm2, 22Rv1 with a seeding 

density of 5.000 cells/cm2 and PC-3 with 2.000 cells/cm2. 

HEPG2 cells were washed with PBS. Prewarmed 0.05% trypsin-EDTA was added and incubated 

for 5 minutes. Cell culture medium was added to neutralize the trypsin. With a seeding density of 

5.000 cells/cm2, the cells were passaged to a new tissue culture flask with fresh medium. 

 

The cell culture medium was replaced every 3-4 days for all cell lines.  

For the PSA secretion experiments LNCaP cells were cultured from passages p.41 to p.45, PC-3 

from p.98 to p.102, RWPE-1 p.65 to p.69, RWPE-2 p.67 to p.75, PWR-E1 px+4 to px+11, 22Rv1 

px+7 to px+11. For the immunofluorescence staining passage numbers LNCaP p.52, PC-3 p.109, 

RWPE-1 p.76, RWPE-2 p.77, PWR-E1 px+12, 22Rv1 px+21 are used. For the expression 

experiments LNCaP p.43, PC-3 p.100, RWPE-1 p.67, RWPE-2 p.68, PWR-E1 px+4, 22Rv1 px+9 

are used. LNCaP p.52, PC-3 p.109, RWPE-1 p.76, RWPE-2 p.77, PWR-E1 px+12, 22Rv1 px+21 

are used. Supernatant for PSA secretion experiments is stored from the following passage 

numbers of the cells LNCaP p.53, PC-3 p.112, RWPE-1 p.77, RWPE-2 p.81, PWR-E1 px+13, 

22Rv1 px+26. 

 
Table 2: Cell culture medium components PWR-E1, RWPE-1 and RWPE-2. 

Reagent Concentration in 

media 

Stock 

concentration 

Catalogue 

number 

Supplier 

Keratinocyte 

serum-free 

medium (SFM) 

- 500 mL 17005042 Gibco 

human 

epidermal 

growth factor 

(EGF) 

5 ng/ml 2.5ug/ml 10450-013 Gibco 

bovine pituitary 

extract (BPE) 

50 µg/ml 25mg/ml 13028-014 Gibco 
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Table 3: Cell culture medium components of LNCaP, 22Rv1 and PC-3 cells 

Reagent Concentration 

in media 

Stock 

concentration 

Catalogue 

number 

Supplier 

Roswell Park 

Memorial Institute 

(RPMI 1640) 

- 500 mL BE12-702F Lonza 

Fetal Bovine Serum 

(FBS) 

10% - F7524 Sigma Aldrich 

Penicillin/streptomycin 100 u and 100 

µg/mL 

10.000 u and 

10.000 µg/ml 

Cat. 

DE17602E 

Lonza 

L-Glutamine 2 mM 200 mM Cat. 

Be17605E 

Lonza 

 
Table 4: Cell culture medium components of HEPG2 cells. 

Reagent Concentration 

in media 

Stock 

concentration 

Catalogue 

number 

Supplier 

Dulbecco's modified 

Eagle's medium 

(DMEM) 

- 500 mL 41965-039 Gibco, 

ThermoFisher 

Scientific 

Fetal Bovine Serum 

(FBS) 

10% - F7524 Sigma Aldrich 

Penicillin/streptomycin 100 u and 100 

µg/mL 

10.000 u and 

10.000 µg/ml 

Cat. 

DE17602E 

Lonza 

 

2.2 Organoid culture 
Circulating tumor cells (CTCs) are interesting cells for individualised disease modelling as they 

reflect phenotypic and genotypic heterogeneity of the tumor (Dathathri et al., 2022)(Mout et al., 

2021). The number of CTCs is associated with prognostic values. CTCs can be obtained from 

mPCa patients by DLA and can be cultured as organoids. These organoids are a more 

representative model of the disease than standard 2D cell lines. However, the success rate of 

generating organoid cultures derived from CTCs is very low. In the study of L. Mout et all, one 

stable CTC-derived organoid cell line (EMC-PCa-41) from an mCRPC patient is generated out of 

40 DLA samples (Mout et al., 2021). The organoid cell line EMC-PCa-41 was cultured in this 

project. 

The organoid cell line EMC-PCa-41 (kindly provided by Erasmus MC, Rotterdam, The 

Netherlands) was used. Cells were thawed and collected by centrifugation at 1200 g for 5 minutes 

at 4⁰C. On ice, Cultrex Reduced Growth Factor Basement Membrane Extract (RGF BME) Type 

R1 (R&D systems, Bio-Techne, Minneapolis, USA) (Matrigel) was added to the cell pellet (Ratio 

cell suspension: Matrigel is 1:3). Droplets of 30µL were made in a  pre-warmed 24-wells plate 

(VWR international B.V., Amsterdam, The Netherlands). Next, the plate was incubated for 30 

minutes upside-down at 37⁰C and 5% CO2. Subsequently, 500µL of adjusted prostate cancer 

organoid medium (APCOM medium) was added. The components are listed in Table 2. The cell 

culture medium was replaced every 2-3 days. The organoids were passaged once a month after 

they were brought into culture.  

For passaging or obtaining single cell suspension, the organoid cells were mechanically disrupted. 

They were resuspended in Advanced DMEM/F12 + Non-Essential Amino Acids + 110 mg/L 

Sodium Pyruvate + L-Glutamide (Gibco, ThermoFisher Scientific, Waltham, USA), supplemented 



14 
 

with HEPES (ThermoFisher Scientific, Waltham, USA) and pen/strep (AdMEM/F12+++). The 

collected cells were centrifuged at 1200g for 5 min and plated as described previously. Another 

method that was used to passage the organoids was with the use of trypsin. TryplE (Gibco, 

ThermoFisher Scientific, Waltham, USA) was added to the wells and incubated for 20-30 minutes 

at 37⁰C. The cell suspension was resuspended and trypsin inhibiter (Merck, Sigma Aldrich, USA) 

(ratio 1:1) was added. Subsequently, this cell suspension was collected in AdMEM/F12 +++ 

medium to wash the cells. After washing, the cells were plated as described previously. 

To evaluate the cell viability, calcein [4µM] (Invitrogen, ThermoFisher Scientific, Waltham, USA) 

was incubated for 30 minutes in one well with organoid cells in Matrigel. Hoechst [, 4µg/mL] 

(Invitrogen, ThermoFisher Scientific, Waltham, USA) was incubated for the last 10 minutes. With 

an inverted fluorescence microscope (Nikon, Eclipse Ti, Minato, Japan), the cells were imaged. 

 

Table 1: Components of Adjusted Prostate Cancer Organoid Medium (APCOM) 

Reagent Concentration in 

media 

Stock 

concentration 

Catalogue 

number 

Supplier 

Advanced DMEM/F12  500 mL 12634010 ThermoFisher 

Scientific 

HEPES 10 mM 1M 15630080 ThermoFisher 

Scientific 

L-Glutamine 2 mM 200 mM Cat. 

Be17605E 

Lonza 

Penicillin/streptomycin 100 u and 100 

µg/mL 

10.000 u and 

10.000 µg/ml 

Cat. 

DE17602E 

Lonza 

Noggin 0.1ug/ml 200ug/ml 120-10C Peprotech 

R-spondin 0.5ug/ml 500ug/ml 120-38 Peprotech 

Epithelial growth factor 

(EGF) 

20 ng/mL 1mg/ml E-9644 Sigma-Aldrich 

Fibroblast growth 

factor 2 (FGF-2) 

5 ng/mL 100ug/ml 233-FB-

025 

R&D Systems 

Fibroblast growth 

factor 10 (FGF-10) 

10 ng/mL 50ug/ml 100-26 PeproTech 

A-83-01 500 nM 25mM 2939 Tocris 

Bioscience 

Prostaglandin Ed 

(PGE2) 

0,5 µM 100mM 1254 Tocris 

Bioscience 

Y-27632 

dihydrochloride 

10 µM 100mM 1254 Abmole 

Bioscience 

Metribolone R1881 5nM 20mM Lot 

#041015 

Biotangusa 

 

2.3 Immunofluorescence staining and imaging 
One flask of each cell line was stimulated with R1881 [0.5ng/mL] (TSZCHEM, Wadeville, South 

Africa) overnight. The next day, 100.000 cells were seeded in a 24 well plate (VWR international 

B.V., Amsterdam, The Netherlands) and R1881 [0.5ng/ml]  or Enzalutamide [2µg/ml] (MDV3100, 

Selleckchem, Houston, USA) was added. Enzalutamide was added to the wells with R1881 

stimulated cells (stimulated overnight), as illustrated in Figure 4. The well plate was incubated for 

24 hours and 48 hours at 37⁰C and 5% CO2. Subsequently, the cells were fixed with 1% formalin 
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(Sigma Aldrich, St. Louis, USA). The cells were permeabilized by washing with 0.1% Triton X-100 

(Sigma Aldrich, St. Louis, USA)  in PBS for 15 minutes. Next, the cells were washed twice with 

PBS and after that 1% Bovine Serum Albumin (BSA) (Sigma Aldrich, St. Louis, USA) in PBS was 

added for 30 minutes.  

For staining, a primary antibody (Rabbit to PSA Ab, Cat. 19554, Abcam, Cambridge, UK) was 

prepared [2µg/mL] in 0.1% BSA in PBS and incubated for 60 minutes. The membranes were 

washed with PBS. A secondary antibody solution was prepared [2µg/ml]  (Goat pAb to Rb IgG, 

Alexa Fluor 488, Cat. 150077, Abcam, Cambridge, UK) in 0.1% BSA in PBS including a PSMA-

PE antibody (FOLH1) [1 µg/ml] (Cat. 342504, BioLegend, San Diego, USA).  

After washing with PBS, DAPI [4 µM] (CellSearch, Menarini Silicon Biosystems, Bologna, Italy) 

was added to the wells and incubated for 15 minutes. The wells were washed with PBS and stored 

in PBS at 4⁰C. With a fluorescence microscope (Nikon, Eclipse Ti, Minato, Japan), the cells were 

imaged. In the DAPI channel, an exposure time of 50 millisecond (ms) was used and in FITC and 

PE channels an exposure time of 200 ms was used. 

2.4 PSA detection in the supernatant (dot blot) 
To detect PSA in the supernatant of cell lines, the supernatant of all cell lines was stored after 7 

days of passaging, excluding RWPE-1 and HEPG2. The supernatant of these cell lines was stored 

after 24 hours and 48 hours after passaging. 

Polyvinylidene fluoride (PVDF) membranes (Immun-Blot, 0.45 µm pore size) (BIO-Rad 

Laboratories B.V., Veenendaal, the Netherlands) membranes were incubated with methanol for 1 

minute and washed with PBS. Droplets of 2 µL of the supernatant were added to the membrane. 

Next, the membranes were blocked using 3% BSA in PBS for 30 minutes. Subsequently, the 

staining protocol, as mentioned in 2.5.3 was performed. 

Figure 4: An illustration of the different prostate cancer cell lines seeded in the wells plate in three conditions. On day 1, 1 
flask was stimulated with R1881. On day 2, the cells were seeded in a well plate. The cells of the untreated flask were split 
into two cell suspensions. One part remained untreated, the other part was stimulated with R1881. Enzalutamide was added 
to the overnight R1881 treated flask.  Blue wells: untreated cells. Orange wells: Cells are androgen stimulated with 0.5nM 
R1881. Green wells: Cells are treated with 2µM Enzalutamide, after overnight incubation with 0.5nM R1881. The well plate 
is in duplicate for the 24-hour and 48-hour timepoint. Created by biorender.com. 
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2.5 Capturing PSA secretion on membranes from PCa cell lines 
A schematic overview of the methodology to capture PSA secretion from the PCa cell lines on 

PVDF membranes is illustrated in Figure 5. 

 

2.5.1 Preparation of the PVDF membranes 

Under sterile conditions, PVDF membranes (Immun-Blot, 0.45 µm pore size) (BIO-Rad 

Laboratories B.V., Veenendaal, the Netherlands) were placed in a 24-wells plate (VWR 

international B.V., Amsterdam, The Netherlands) and incubated with methanol (100%) for 1 

minute. Membranes were washed twice with 1X PBS. Subsequently, a monoclonal mouse anti-

PSA antibody solution (Cat.10-P21A, Fitzgerald Industries International, Acton, USA) with a 

concentration of 25µg/mL in 1x PBS was prepared and added to the membranes. The membranes 

were incubated overnight at 4⁰C. The next day the antibody solution was removed and a 3% BSA 

in 1X PBS solution was added to block the membranes for 1 hour. Membranes were washed with 

1X PBS. 

2.5.2 Capturing PSA secretion from PCa cell lines 

One flask of each cell line was stimulated with R1881 [0.5ng/mL] overnight. The next day 2000 

cells were seeded on the membranes and R1881 [0.5ng/mL] or Enzalutamide [2µg/ml ] was 

added to the cells on the membranes. Enzalutamide was added to the membranes with R1881 

stimulated cells (overnight stimulation). A schematic overview of the method to seed cells on a 

membrane, is shown in Figure 4. The membranes were incubated at 37⁰C and 5% CO2. After the 

first 24 hours, the medium cell culture medium was removed from half of the membranes and 

these membranes were washed with 1% Tween 80 (Sigma Aldrich, St. Louis, USA) in PBS for 30 

minutes on a thermoshaker (Thermomixer C, Eppendorf, Hamburg, Germany) at 300 rpm to wash 

the cells off. This was followed by washing with 1% BSA in PBS for 30 minutes on the 

thermoshaker at 300 rpm. After 48 hours of incubation, the other half of the membranes 

underwent the same steps.  

 

Figure 5: A schematic overview of capturing PSA secretion on membranes. Created by biorender.com. 



17 
 

2.5.3 Detection of PSA 

To visualize the PSA which is captured on the membranes, a primary antibody [2µg/mL] (Rabbit 

to PSA Ab, Cat. 19554, Abcam, Cambridge, UK) was diluted in 1% BSA in PBS. The antibody 

solution was added to the membranes and placed on the thermoshaker for 1 hour at 300 rpm. 

The membranes were washed three times for 5 minutes with 1% BSA in PBS. Subsequently, a 

secondary antibody was prepared [2µg/ml]  (Goat pAb to Rb IgG, Alexa Fluor 488, Cat. 150077, 

Abcam, Cambridge, UK) in 1% BSA in PBS. The antibody solution was added to the membranes 

and placed on the thermoshaker for 1 hour at 300 rpm. Again, the membranes were washed three 

times for 5 minutes with 1% BSA in PBS. The stained membranes were dried and placed between 

two microscope slides. Using the VyCAPs scan program the membranes were imaged using an 

inverted microscope (Nikon, Eclipse Ti, Minato, Japan) in the FITC channel using an exposure 

time of 20 ms, with a 10x objective. Around 10x10 images were acquired. A montage of these 

images was made using Image J software and saved in tiff format.   

Due to a change in the optical fibre of the microscope the images of the first experiments were 

imaged with an exposure time of 50 ms. In Supplementary Table 1, an overview of all datasets 

and their properties is shown. 

2.5.4 Calibration curve 

A serial dilution (0-300 µg/mL) of the Prostate Specific Antigen peptide (Cat. no. ab41421, Abcam, 

Cambridge, UK) was prepared and droplets of 2 µL of each concentration were spotted in 

triplicates on the PVDF membranes. PSA was detected as mentioned in Section 2.5.2. The spots 

were analysed using the Image J software. The mean intensity and the size of each spot were 

determined. The amount of PSA present in one spot was divided by the area of the spot to 

calculate the amount of PSA in pg/µm2. The different amounts of PSA in pg/µm2 versus the mean 

intensity were plotted. To determine the amount of PSA secreted by a cell, the amount of PSA in 

pg/µm2 was multiplied by the area of the spot. The amount of PSA pg/µm2 can be read out in the 

calibration curve using the mean intensity of the spot. 

2.5.5 Quantification 

The quantification was done using the Image J software. A montage of the individual images was 

made and saved as a TIFF file. The image was duplicated and the duplicated image was saved as 

a 10-bit image. Then a threshold was set on the duplicated image with a minimum pixel intensity 

of 550. A binary image was created and linked to the original image. The area and the mean 

intensity of the regions of interest were computed. The values of the mean intensity were 

normalized to the membranes of the HEPG2 cells. A more detailed protocol, with some exceptions, 

is presented in the Supplementary Data. 

 

2.6 Enzyme-linked immunosorbent assay 
A monoclonal mouse anti-PSA antibody solution [25µg/mL] (Cat.10-P21A, Fitzgerald Industries 

International, Acton, USA) in 1x PBS was prepared and used to coat a 96 microwell immuno plate 

(172164, Sigma Aldrich, St. Louis, USA). This capture antibody was incubated overnight. The 

next day, the wells were washed with 1% Tween 20 (Sigma Aldrich, St. Louis, USA) and 1% BSA 

in PBS was incubated for 1 hour. The samples of interest were diluted in 1% BSA and 5% FBS in 

PBS and samples for a calibration curve were prepared. For the calibration curve serial dilutions 

of the Prostate Specific Antigen peptide (Cat. no. ab41421, Abcam, Cambridge, UK) were made 

from 0 to 60 ng/ml. Only LNCaP samples were diluted as described in Table 5. 

The wells were washed again and the diluted samples and the samples for the calibration curve 

were incubated (100 µL/well) for 2 hours. Next, a primary antibody [2µg/mL] ((Rabbit to PSA Ab, 
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Cat. 19554, Abcam, Cambridge, UK) was prepared in 1% BSA in PBS and incubated for 1 hour. 

The wells were washed again and an anti-rabbit-HRP [3 µg/ml] (Dako, Agilent, Santa Clara, USA) 

solution in 1% BSA in PBS was prepared and incubated for 20 minutes in the dark. The wells were 

washed again and streptavidin (Lot.P300867, R&D systems, Minneapolis, USA)) diluted in 1% 

BSA in PBS [dilution1:40] was added. After washing 1-Step™ Ultra TMB-ELISA Substrate Solution 

(Thermo Scientific, ThermoFisher Scientific, Waltham, USA ) was incubated until a clear difference 

in different shades of blue was visible in the standard. Subsequently, 1.8M H2SO4 (Sigma Aldrich, 

St. Louis, USA) in MilliQ was prepared and added to the wells. The absorbance was measured 

using a VictorX3 microplate reader (PerkinElmer, Waltham, USA). 

 
Table 5: Dilution factors of ELISA samples 

Cell line Conditions Dilution factor 

LNCaP Supernatant is collected after 

7 days. On day 7 an 80% 

confluency. T25 flask. 

100x 

LNCaP 100.000 cells seeded in a 24-

wells plate. Stimulated with 

R1881. Supernatant is 

collected after 48 hours. 

400x 

 

 

 

2.7 Flow cytometry 
100.000 cells were collected in a tube and fixed using 1% formalin in PBS for 15 minutes. The 

cells were washed with PBS. The cells were centrifuged for 5 minutes at 500 Relative Centrifugal 

Force (RCF). The supernatant was aspirated and the cell suspension samples were divided into 

different samples. To each sample, 100 µL of different primary antibody solutions were added. 

The different primary antibody solutions were HER2/neu [1µg/ml] (Immunicon, Huntingdon Valley, 

USA), VU1D9 [1µg/ml] (Veridex), and Purified anti-human PSMA (FOLH1) (Cat. 342502) 

[10µg/ml] (BioLegend, San Diego, USA). 

The primary antibodies were incubated at 37°C for 30 minutes. Cells were washed with 1% BSA 

in PBS. A secondary antibody solution (F(ab')2-Goat anti-Mouse IgG (H+L), PE) [2.5µg/ml]  

(FisherScientific, ThermoFisher Scientific, Waltham, USA) was prepared, added to each sample 

and incubated at 37°C for 30 minutes. Cells were washed with 1% BSA in PBS. The samples were 

measured with the FACS device (BD Bioscience, Franklin Lakes, USA). BD Quantibrite™ PE (BD 

Bioscience, Franklin Lakes, USA) were used to make a standard curve.  

 

2.8 Graphs and statistical analysis 
The graphs were created using the software GraphPad Prism (Version 5, GraphPad Software, 

San Diego, USA). Statistically significant differences between the two conditions were 

determined using Student’s t-test. Differences with P-values of < 0.05 were considered 

statistically significant. * 0.05 < P  **0.01< P ***0.001< P 
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3 Results and discussion 

3.1 EMC-PCa-41 organoids 
The EMC-PCa-41 organoids were thawed and plated in Matrigel as mentioned in Section 2.3, see 

Figure 6. The EMC-PCa41 organoids were kept in Matrigel and observed for growth. The growth 

of cells was very slow and no organoid formation was visible for 

four weeks. The cells were passaged and re-seeded in new 

Matrigel. 

Immunofluorescence staining was performed to visualize the 

presence of PSA protein, PSMA surface marker and the 

nucleus. The immunofluorescence staining showed the 

presence of no cells. This could indicate that most cells were 

dead and lost during the staining protocol. Cell counting also 

showed the presence of no cells, hence viability (trypan blue) 

staining could not be performed to confirm the presence of live 

cells during passaging.    

To check for viability, Calcein and Hoechst staining were 

performed. Only a few cells were visualized, as shown in Figure 

7. Calcein staining was not observed, indicating the absence of 

live cells.  

The supernatant of the EMC-PCa-41 cells was stored every month consecutively to check for the 

presence of PSA protein in the supernatant. These results are described in Section 3.3. 

We did not succeed to culture EMC-PCa-41 organoids. This could be due to different reasons. A 

month after thawing, the organoids were passaged for the first time. Earlier passaging of the 

organoids might have led to higher stability of the Matrigel and perhaps a more optimal 

environment for the organoid cells.  Besides, after passaging the organoids, a lower cell density 

was observed. The lack of cell-cell contact could complicate the ability to generate organoids.  

Lastly, culturing CTC-derived prostate cancer organoids can be very challenging. In the study of 

L. Mout et al., 14 CTC derived organoids were established out of 40 DLA samples. However, only 

two organoid cultures could be maintained for over six passages (Mout et al., 2021). It might be 

that the current culture techniques do not provide an optimal environment for sustained viability.  

Nevertheless, we cannot explain why we did not succeed to culture the EMC-PCa-41 organoids. 

Figure 6: An image of EMC-PCa-41 
cells after thawing and plating in 
Matrigel in a wells plate. 

Figure 7: Images of EMC-PCa-41 organoid cells in Matrigel, 14 weeks after thawing. The cells are stained with Calcein and 
Hoechst (blue, DAPI). a) Merge of Bright field and Hoechst, b) Bright field, c) Hoechst. Calcein is not observed, indicating the 
absence of life cells. Exposure time is 250 ms. Scale bar: 80 µm. 
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3.2 Phenotypic characterization of prostate cancer cell lines in response to drugs  
The immunofluorescence staining of prostate cancer cell lines was performed with anti-PSA 

(Alexaflurophore AF488),  antiPSMA (PE) and DAPI to visualize the presence of PSA protein, 

PSMA surface marker and the nucleus respectively. Additionally, the cells were androgen 

stimulated for 24 hours with R1881 and AR inhibited with Enzalutamide, as described in Section 

2.3. The phenotypic assessment of the following prostate cancer cell lines is shown below. 

 

3.2.1 PWR-E1 (benign) 

The PWR-1E cells showed a monolayer of cells and appear healthy and stretched (Figure 8).  

The immunofluorescent images of PWR-1E 

cells (Figure 9) show the presence of 

intracellular PSA protein in the three conditions 

(untreated, androgen stimulated, and AR 

inhibited). However, PSA protein is not 

expected throughout the nucleus of the cell. 

The presence of unspecific staining in the 

nucleus of the cells is indicated with red arrows 

in Figure 9i. Specific staining of PSA in the 

cytoplasm is indicated by green arrows as 

shown in Figure 9g,i. A possible reason for the 

unspecific staining can be attributed to the non-

specific binding of the secondary antibody to 

the cell nucleus. To confirm this, the primary 

antibody in a next experiment should be 

absent. 

No PSA protein was observed in the cytoplasm of the untreated and androgen stimulated cells 

(Figure 9 a,c,d,f). However, our results indicate the presence of the PSA protein after treatment 

with Enzalutamide (Figure 9 g,i). This is contradictory to findings in the literature. Literature 

indicates also the presence of cellular PSA in untreated PWR-E1 cells using western blot (Deep et 

al., 2008). These experiments must be repeated to confirm these contradictory findings. 

PSMA expression was not observed in the PWR-1E cell line. No other research is done into PSMA 

expression in PWR-1E cells. 

Figure 8: A bright field image of PWR-E1  cells. Cells show a 
stretched morphology. Scale bar: 100 µm. 
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Figure 9: Immunofluorescence detection of both PSA and PSMA expression in PWR-E1 cells following androgen stimulation 
(R1881) or Enzalutamide treatment. Cell nuclei were counterstained with DAPI (blue). A,b,c) Untreated PWR-E1 cells. d,e,f) 
Androgen stimulated (R1881) PWR-E1 cells. F,h,i) Enzalutamide treated PWR-E1 cells. Specific fluorescence signals for PSA 
(green) were detected, indicated by the green arrows. Fluorescence signals for PSA throughout the nuclei (red arrows) are 
not indicated as true PSA expression. No signals for PSMA were detected in PWR-E1 cells (not shown). Scale bar: 50 µm 
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3.2.2 RWPE-1 (benign) 

The immunofluorescent images of RWPE-1 cells are shown in Figure 10. Figure 10 (a,c,d,f,g,i) 

indicated the absence of PSA protein in the cytoplasm in all three conditions (untreated, androgen 

stimulated and AR inhibited). 

From the clinic is known that benign prostate cells secrete in general lower PSA levels than 

cancerous prostatic cells (Tikkinen et al., 2018). This is in accordance with our results. We did not 

identify PSA expression in the benign RWPE-1 cell line. 

However, the study of D. Bello et all reported PSA expression in RWPE-1 cells after 6 days of 

treatment with mibolerone, a non-metabolizable androgen (Bello et al., 1997). This is contradictory 

to our findings. This may be due to the different stimulation compounds and stimulation time. 

PSMA expression was not observed in RWPE-1 cells. This is in accordance with the literature, as 

RWPE-1 is classified as a benign and a PSMA-negative cell line (Tse et al., 2015).  

Figure 10:  Immunofluorescence detection of both PSA and PSMA expression in RWPE-1 cells following androgen stimulation 
(R1881) or Enzalutamide treatment. Cell nuclei were counterstained with DAPI (blue). A,b,c) Untreated RWPE-1 cells. d,e,f) 
Androgen stimulated (R1881) RWPE-1 cells. F,h,i) Enzalutamide treated RWPE-1 cells. Specific fluorescence signals for PSA 
(green) were not detected outside the nuclei. No signals for PSMA were detected in RWPE-1 cells (not shown). Scale bar: 50 
µm 



23 
 

 

3.2.3 RWPE-2 (hormone-sensitive) 

The RWPE-2 cells appeared stellated shaped with 

some long cytoplasmic processes (Figure 11). 

The immunofluorescent staining on RWPE-2 cells 

indicated increased cellular PSA expression after 

androgen stimulation, as shown in Figure 12 (a,c,d,f). 

This is in accordance with the article of D. Bello et al.. 

This study detected no PSA expression in untreated 

cells, but observed PSA expression in RWPE-2 cells 

after 6-day of treatment with androgen mibolerone 

(Bello et al., 1997). 

Figure 12 suggests low levels of PSA expression in 

untreated hormone-sensitive RWPE-2 cells, elevated 

PSA expression levels after androgen stimulation and 

again low PSA expression levels when the cells are AR inhibited using Enzalutamide. This is in line 

with expectations of a hormone-sensitive cell line. Hormone-sensitive PCa patients react to 

hormone therapies, like enzalutamide, which results in lower PSA levels (Perlmutter & Lepor, 

2007).  

PSMA is highly expressed in PCa cells. However, PSMA expression is heterogeneous and some 

patients and PCa cell lines lack PSMA expression (Sheehan et al., 2022). This is in accordance 

with our results. PSMA expression was not observed in the hormone-sensitive cell line RWPE-2. 

Our results suggest that RWPE-2 is a PSMA negative cell line. 

Figure 11: A bright field image of RWPE-2 cells. 
Cells show a stretched morphology. Scale bar: 
100 µm. 
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3.2.4 LNCaP (hormone-sensitive) 

The LNCaP cells showed a monolayer of stellate 

shaped cells and appeared stretched (Figure 13). 

The images of the immunofluorescence staining in 

LNCaP cells are shown in Figure 14. Figure 14 

(c,d,g,h,k,l) indicates that in all three conditions PSA, 

as well as, PSMA was expressed. This is in 

accordance with findings in the literature. Results by 

T.M. gorges et all. and B. Sheehan et all. observed 

PSMA expression using immunofluorescence 

staining in LNCaP cells (Gorges et al., 

2016)(Sheehan et al., 2022). Other studies reported 

PSA expression in LNCaP cells using techniques 

such as immunohistochemistry (IHC) and western blot (Sasaki et al., 2016) (Deep et al., 2008). 

Figure 13: A bright field image of LNCaP cells. Cells 
show a stellate-shaped morphology. Scale bar: 100 
µm. 

Figure 12: Immunofluorescence detection of both PSA and PSMA expression in RWPE-2 cells following androgen stimulation 
(R1881) or Enzalutamide treatment. Cell nuclei were counterstained with DAPI (blue). A,b,c) Untreated RWPE-2 cells. d,e,f) 
Androgen stimulated (R1881) RWPE-2 cells. F,h,i) Enzalutamide treated RWPE-2 cells. Specific fluorescence signals for PSA 
(green) were detected outside the nuclei. Upon androgen stimulation a higher signal of PSA is detected. No signals for PSMA 
were detected in RWPE-2 cells (not shown). Scale bar: 50 µm 
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The androgen stimulated cells indicated elevated PSA expression (Figure 14 g) and the AR 

inhibited cells indicated lower PSA expression (Figure 14 k). This is in line with findings in the 

literature. The same effect of androgen stimulation and AR inhibition on PSA secretion is observed 

in other studies (Abali et al., 2021). This is also in line with expectations of a hormone-sensitive 

cell line. Hormone-sensitive PCa patients react to hormone therapies, like enzalutamide, which 

results in lower PSA levels (Perlmutter & Lepor, 2007). 

Our results observed the presence of the PSMA protein in the hormone-sensitive LNCaP cell line. 

In addition, our results indicated elevated PSMA expression levels after androgen stimulation, 

compared to the untreated cells (Figure 14 d,h) and the similar PSMA levels of untreated LNCaP 

cells and AR inhibited LNCaP cells. This is contradictory with the study of M. Staniszewska et al.. 

This study observed elevated PSMA levels in LNCaP cells after treatment with enzalutamide 

(Staniszewska et al., 2021). These differences must be interpreted with caution because, in the 

study of M. Staniszewska et al. LNCaP cells were treated with 10µM Enzalutamide for at least one 

week. In our study, LNCaP cells were treated with 2 µM Enzalutamide for 24 hours. 

 

  

Figure 14: Immunofluorescence detection of both PSA and PSMA expression in LNCaP cells following androgen stimulation 
(R1881) or Enzalutamide treatment. Cell nuclei were counterstained with DAPI (blue). A,b,c,d) Untreated LNCaP cells. e,f,g,h) 
Androgen stimulated (R1881) LNCaP cells. I,j,k,l) Enzalutamide treated LNCaP cells. Specific fluorescence signals for PSA 
(green) and PSMA (red) were detected outside the nuclei.  Upon androgen stimulation, a higher signal of PSA and PSMA is 
detected. Scale bar: 50 µm 
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3.2.5 22Rv1 (castration-resistant) 

The 22Rv1 cells showed an epithelial rectangular 

shaped morphology. Most of the cells were clustered 

together (Figure 15) 

The immunofluorescence images in figure 16 showed 

the presence of the PSA and PSMA protein in the 

22Rv1 cell line, under different conditions. Only very 

low levels of PSA expression were detected in 

androgen stimulated 22Rv1 cells, which is 

contradictory to findings in the literature. Previous 

studies showed PSA expression of untreated 22Rv1 

cells using techniques such as western blot (Sasaki et 

al., 2016)(Deep et al., 2008). These experiments must 

be repeated to confirm these contradictory findings. 

High expression of PSMA is expected in castration-resistant cell lines, but due to PSMA 

heterogeneity, this differs per cell line and patient. Our results indicated low levels of PSMA 

expression in a subpopulation of the 22Rv1 cells. These findings follow a similar observation with 

the literature. T.M. Gorges reported less than 30% PSMA positive 22Rv1 cells and M. 

Staniszewska et al., showed around 20% PSMA positive 22Rv1 cells (Gorges et al., 

2016)(Staniszewska et al., 2021). 

Comparable PSMA expression levels were detected in the untreated and androgen stimulated 

cells (Figure 16 d,h). However, no PSMA was detected in the AR inhibited 22Rv1 cells (Figure 16 

l). This is contradictory to findings in the literature. The study of M. Staniszewska et al. indicated 

Figure 15: A bright field image of 22Rv1 cells. Cells 
show an epithelial rectangular-shaped morphology. 
Scale bar: 100 µm. 

Figure 16: Immunofluorescence detection of both PSA and PSMA expression in 22Rv1 cells following androgen stimulation 
(R1881) or Enzalutamide treatment. Cell nuclei were counterstained with DAPI (blue).  A,b,c,d) Untreated 22Rv1 cells. 
e,f,g,h) Androgen stimulated (R1881) 22Rv1 cells. I,j,k,l) Enzalutamide treated 22Rv1 cells Specific fluorescence signals for 
PSA (green) and PSMA (red) were detected minimal outside the nuclei upon androgen stimulation. Scale bar: 50 µm 
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increased PSMA levels after treatment with enzalutamide. These differences must be interpreted 

with caution because in the study of M. Staniszewska et al., 22Rv1 cells are treated with 10µM 

Enzalutamide for one until three weeks (Staniszewska et al., 2021). In our study, 22Rv1 cells were 

treated with 2 µM Enzalutamide for 24 hours. These experiments must be repeated under the 

same conditions to confirm these contradictory findings. 

 

3.2.6 PC-3 (castration-resistant) 

The PC-3 cells showed a monolayer of stellate 

shaped cells with some long cytoplasmic processes 

(Figure 17). 

No PSA expression was observed in castration-

resistant PC-3 cells (Figure 18 c,f,i), which is in 

accordance with the literature. It is well known that 

PC-3 cells do not express PSA (Tai et al., 

2011)(Yamamoto et al., 2020).  

This is not in line with the fact that most mCRPC 

patients have elevated PSA levels. However, there 

are 

Figure 17: A bright field image of PC-3 cells. Cells 
show a stretched morphology. Scale bar: 100 µm. 

Figure 18: Immunofluorescence detection of both PSA and PSMA expression in PC-3 cells following androgen 
stimulation (R1881) or Enzalutamide treatment. Cell nuclei were counterstained with DAPI (blue). A,b,c) Untreated 
PC-3 cells. d,e,f) Androgen stimulated (R1881) PC-3 cells. F,h,i) Enzalutamide treated PC-3 cells. Specific fluorescence 
signals for PSA (green) were not detected outside the nuclei.  No signals for PSMA were detected in PC-3 cells (not 
shown). Scale bar: 50 µm. 
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exceptions and some aggressive mCRPC tumours have also low PSA levels (Tikkinen et al., 

2018)(Carm et al., 2019). 

In addition, no PSMA staining was observed in PC-3 cells, which is in accordance with the 

literature (Laidler, Dulińska, Lekka, & Lekki, 2005). As previously described, PSMA is generally 

expressed in mCRPC patients. However, due to heterogeneity in PSMA expression, there is a high 

variation. 

Overview immunofluorescent staining 

In Table 6, a summary of the immunofluorescence staining is presented. The score is based on a 

subjective interpretation from an independent individual. The immunofluorescent images (without 

the name of the belonging cell line and condition) were shown to an individual, which ranked the 

images based on the intensity of the green and red staining in the cytoplasm of the cells in an 

unbiased manner. 

Table 6: Summary of immunofluorescence PSA and PSMA staining in different PCa cell lines.  

 

PSMA is expressed in PCa cells and it can be increased in mCRPC cells. In our study, PSMA 

expression was only detected in LNCaP (hormone-sensitive) and 22Rv1 (castration-resistant) 

cells. PSMA levels were higher in the hormone-sensitive LNCaP cells compared to the castration-

resistant 22Rv1 cells. This is in line with the literature (Gorges et al., 2016)(Xia et al., 2021). In 

addition, an increase in PSMA expression was identified after androgen stimulation in LNCaP cells. 

The differences in PSMA expression in the different hormone-sensitive and castration-resistant 

cell lines can be due to heterogeneity of PSMA expression (Sheehan et al., 2022). 

PSA expression was observed in PWR-E1 (benign), RWPE-2 (hormone-sensitive), LNCaP 

(hormone-sensitive) and 22Rv1 (castration-resistant) cells. Androgen stimulation (R1881) was 

expected to increase PSA levels and enzalutamide to decrease PSA levels in hormone-sensitive 

cells. This was also the case in the hormone-sensitive RWPE-2 and LNCaP cell lines. 

Figures 9,10,12 and18 suggest nuclear localization of PSA. However, nuclear localization of PSA 

was also observed in the negative control HEPG2 cell line (Supplementary Figure 10) and in the 

PSA negative cell line PC-3 (Figure 18). This was not identified in the literature (Kuske et al., 2016). 

In addition, other studies detected cytoplasmic PSA instead of PSA throughout the nucleus (Theil, 

Bialek, Weiß, Lindner, & Fornara, 2022)(Tang, 2022)(Qin et al., 2012). Therefore, we identified 

nuclear PSA staining as non-specific, this could be attributed to the non-specific binding of the 

secondary antibody to the cell nucleus. To confirm this, the primary antibody in a next experiment 

should be absent.  

Disease 

state 

Cell 

line 

Passage 

number 

PSA PSMA 

-

R1881 

+R1881 +Enzalutamide -

R1881 

+R1881 +Enzalutamide 

B
e

 

PWR-

E1  

Px+12 - - ++ - - - 

RWPE-

1  

76 - - - - - - 

H
S

 

RWPE-

2  

77 + ++ - - - - 

LNCaP  52 ++ +++ + ++ +++ ++ 

C
R

 22Rv1  Px+21 - + - + + - 

PC-3  109 - - - - - - 
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3.3 Secretions study of prostate cancer cell lines in response to drugs 
The prostate cancer cell lines were further evaluated for their PSA secretion in response to 

androgen stimulation and inhibition. This chapter will provide a comparative analysis of the PSA 

secretions in the supernatant and from single cells, among the different PCa cell lines in response 

to androgen stimulation and AR inhibition. 

3.3.1 PSA detection in the supernatant (dot blot) 

The supernatant of the cells was collected after 7 days from a flask of 60-80% confluency and 

spotted on a PVDF membrane. Using a staining protocol which is illustrated in Figure 19, the PSA 

in the supernatant is detected.  

An example of how fluorescence spots of supernatant of LNCaP cells look on a membrane is 

shown in Figure 20. 

 

 

 

 

 

 

 

 

 

 

The area and the mean intensity of the fluorescent spot can be determined using ImageJ. The 

mean intensity of the membrane is subtracted. 

Using a calibration curve, the data can be converted into quantitative data and the exact amount 

of PSA can be determined. However, the calibration curve (Supplementary Figure 1) could not be 

optimized due to the lack of reproducibility. The current calibration curve resulted in unreliable 

exact amounts of PSA, compared with the ELISA experiment and literature. Therefore, it was 

decided not to use the calibration curve and to use relative values to compare PSA secretion 

between cell lines and conditions.  

 

3.3.1.1 LNCaP (hormone-sensitive) 

The supernatant of LNCaP cells was spotted (2 µL droplets) on a membrane as shown in Figure 

21. The fluorescent spots indicated PSA secretion by LNCaP cells. It is well known that LNCaP 

cells secrete PSA (Sasaki et al., 2016) (Yamamoto et al., 2020)(Deep et al., 2008). The mean 

intensity of the fluorescence spots is 1129 units. Due to the lack of a calibration curve, it is not 

known how many ng PSA is in one spot. 

The images of the membranes showed the presence of black lines (Figure 21) which can be 

attributed to a limitation of the camera. This resulted in an intensity difference in a single image. 

The left sight of a single image has a lower intensity compared to the rest of the image 

Figure 19: Illustration of the detection of PSA in the supernatant of PCa 
cell lines. Supernatant is spotted on a PVDF membrane. In the case of 
PSA in the supernatant, anti-PSA Rabbit bounds to the PSA. Using anti-
Rabbit AF488 the PSA is visualised. Created with Biorender.com 

Figure 20: Four droplets of supernatant 
of LNCaP cells on a PDVF membrane. 



30 
 

(Supplementary Figure 11). Therefore, the fluorescent spots lack a homogeneous intensity 

thereby influencing the mean intensity.  

No fluorescent dots were detected when spotting the cell culture medium of LNCaP cells on a 

membrane. 

 

 

 

 

 

 

 

 

 

3.3.1.2. 22Rv1 (castration-resistant) 

A membrane with spots of the supernatant of 22Rv1 cells is shown in Figure 22. The spots were 

a bit dimmer than the spots of the supernatant of LNCaP cells, as shown in Figure 21. This 

corresponds to the mean intensity of the spots, which is 90 units for the fluorescence spots of the 

22Rv1 cells and 1129 units for the spots of LNCaP cells. This is consistent with similar 

observations in the literature. Other studies reported lower levels of PSA secretion by 22Rv1 cells 

compared to LNCaP cells. These results were 

acquired using western blot (Sasaki et al., 

2016) (Deep et al., 2008).  

No fluorescent dots were detected when 

spotting the cell culture medium of 22Rv1 cells 

on a membrane. 

 

 

3.3.1.3 EMC-PCa-41(castration-resistant) 

A membrane with spots of supernatant of EMC-PCa-41 organoid cells is shown in Figure 23. The 

supernatant was collected 48 hours after refreshing the cell culture medium and at different times 

(1st week, 2nd week and 6th week) after thawing of the EMC-PCa-41 organoid cells. The fluorescent 

spots were dim, a mean intensity of 32 (1st week), 34 (2nd week) and 21 (6th week) units is 

measured. 

However, these data must be interpreted with caution because very dim dots were also observed 

after spotting the medium of EMC-PCa-41 cells (Supplementary Figure 12). This could be due to 

Figure 21: Three droplets of 2 µL of supernatant of LNCaP cells 
spotted on a PVDF membrane. 

Figure 22: Three droplets of 2 µL of supernatant of 22Rv1 
cells spotted on a PVDF membrane. 
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some components in the APCOM medium. A 

mean intensity of 21 units of the dots of the 

APCOM was measured, which is comparable 

to the mean intensity of the supernatant which 

is collected in the 6th week after thawing. 

The mean intensity value of the spots of the 

medium of EMC-PCa-41 cells was subtracted 

from the mean intensity from the supernatant 

from the EMC-PCa-41 cells. 

No earlier research is done into PSA secretion 

of EMC-PCa-41 cells. However, L. Mout et all 

reported positive PSA IHC staining. In addition, 

positive KLK3 (PSA encoded gene) expression 

was identified by qRT-PCR (Mout et al., 2021). 

 

 

3.3.1.4 Overview 

No fluorescent spots of the spotted supernatant of the cell lines RWPE-1, RWPE-2, PWR-E1, PC-

3 and HEPG2 were observed. This is in accordance with the literature. Other studies did not 

identify PSA in the supernatant of these cell lines using western blot (Sasaki et al., 2016) 

(Yamamoto et al., 2020)(Deep et al., 2008)(Tai et al., 2011). 

In the hormone-sensitive cell line LNCaP higher PSA levels were detected in the supernatant 

compared to the PSA levels in the castration-resistant cell lines. No PSA secretion was detected 

in the supernatant from the benign cell lines. An overview of the findings is presented in Table 7. 

Table 7: Overview: PSA observed in supernatant in the PCa cell lines. 

Disease 

state 

Cell line Mean intensity of 

fluorescent spot in units 

Passage numbers 

B
e
 PWR-E1  Below detection limit Px+13 

RWPE-1  Below detection limit 77 

H
S

 RWPE-2  Below detection limit 81 

LNCaP  1129 53 

C
S

 22Rv1  90 Px+26 

PC-3  Below detection limit 112 

O
rg

a
n

o
id

s 

EMC-PCa-41 (1st week) 

EMC-PCa-41 (2nd week) 

EMC-PCa-41 (6th week) 

11  

13 

Below detection limit 

Px+1 

Px+1 

Px+2 

 

 

Figure 23: Nine droplets of 2 µL of supernatant of EMC-PCa-41 
cells spotted on a PDVF membrane. Each row represents three 
droplets of supernatant of EMC-PCa-41 cells obtained from a 
different date. 
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3.3.2 PSA detection on membranes.  

To evaluate the PSA secretion from the single 

cells,  cells were seeded on an anti-PSA coated 

membrane for 24 and 48 hours. The cells are 

seeded on a membrane in three different 

conditions (untreated, androgen stimulated, AR 

inhibited) as mentioned in Section 2.5. Using a 

staining protocol (Figure 24) the captured PSA on 

the PVDF membrane can be visualized.  

An example of how a membrane with captured 

PSA looks, is shown in Figure 25. 

 

 

 

 

 

 

 

 

 

 

3.3.2.1 Quantification 

The images were further analysed with ImageJ to identify PSA secretion spots and quantitatively 

assess PSA secretion in response to drugs.  

Montages of the membranes were opened in ImageJ and a duplicated image is created. The 

duplicated image was saved as a 10-bit image and an intensity threshold of 550 was set.  This 

threshold was chosen based on membranes of LNCaP and HEPG2 cells. On the membranes of 

the LNCaP cells, it was observed that at this threshold most of the spots are not merged, see 

Figure 26. In addition, not many spots 

are missed. On the membranes of the 

HEPG2 cells, only a few small spots 

were detected at this threshold. A 

binary image was created in which 

pixels with an intensity higher than 

550 units become black and pixels 

with an intensity lower than 550 units 

become white, as shown in Figure 27. 

The black dots were the regions of 

interest. The binary image was linked 

to the original image. From the pixels 

Figure 24: Illustration of detection of captured PSA on 
coated PDVF membranes. PVDF membrane is coated 
with anti-PSA. PSA secreted by cell lines is captured on 
the coated membrane. An anti-PSA rabbit AB and anti-
rabbit AF488 AB are added to visualize the captured PSA. 
Created with Biorender.com  

a

Figure 26: PVDF membranes with PSA secretion of LNCaP cells. Red 
indicates an intensity above the intensity threshold. a) Intensity 
threshold set at 550. Spots are not merged. B) Intensity threshold set 
at 500. Three spots are merged. 

b

Figure 25: PVDF membrane with 
captured PSA, secreted by 2000 LNCaP 
cells. 
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of the black dots in the binary image, the area and the mean intensity in the original image were 

computed. The intensity values were normalized to the background and HEPG2 cells.  

The area of the dot was multiplied by the mean intensity of the dot. This gives a value of the amount 

of PSA that is secreted by the cell which is correlated to the dot, see Figure 28. A more elaborated 

quantification protocol is present in the Supplementary Data. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Due to a change in microscopic fiber during the experiments, there is a change in exposure time 

and in the intensity threshold between some datasets. An overview of the datasets and their 

properties is shown in Supplementary Table 1. Due to the lack of a calibration curve, which is 

scanned with both fibers, it is not possible to compare the datasets which are scanned with a 

different fiber.   

ba  

Figure 27: a) PDVF membrane with PSA secretion spots of untreated LNCaP cells. b) An intensity threshold is set at 550. Red 
pixels indicate an intensity above 550. C) Binary image created with the intensity threshold of 550. Red pixels become black, 
the other pixels become white. 

Figure 28: An illustration to calculate the relative amount PSA 
which is secreted by an individual cell. Black dots are the 
regions of interest. The area of a dot is multiplied by the mean 
intensity of the pixels of the original image, located at place of 
the black dot. 
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3.3.2.1 Negative controls 

As a negative control, HEPG2 cells were used and treated as per protocols mentioned in Section 

2.5.2. HEPG2 origins from human hepatocyte carcinoma (Donato, Tolosa, & Gómez-Lechón, 

2015) and do not secrete any PSA. As an extra negative control, an empty membrane was treated 

the same as the other cell lines. The empty membranes looked similar to membranes on which 

HEPG2 cells were seeded. Small dim dots were visible on both membranes, as shown in Figures 

29 and 30. These spots are probably not PSA secretion. The detected spots could be artefacts, 

clustering of staining antibodies or background spots of the membrane. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The quantification method was applied to all these membranes. The results are shown in Figure 

31. 

The mean value of all PSA spots of HEPG2 cells (1.3*106  for experiments with old fiber and 

5.3*106 for experiments with new fiber) was in the same range as the mean value of the PSA spots 

detected from the empty membrane (3.7*106) 

Figure 30: Membrane seeded with HEPG2 cells which are stimulated with 
R1881. Small fluorescence dots are detected. 

Figure 29: Empty PVDF membrane which are treated according to the protocols listed in 
Section 2.5.2, stimulated with R1881. Small fluorescence dots are detected. 
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The mean value of all spots of the HEPG2 cells is used as a threshold for the other cell lines in the 

next experiments. All spots with a value of less than the mean value of HEPG2 cells are considered 

not to be secretion and are not shown in the following graphs (HEPG2 passage numbers 

unknown).  

 

3.3.2.2 LNCaP (hormone-sensitive) 

The membranes with PSA secretion of LNCaP cells of one experiment are shown in Figure 32. 

An anti-PSA coated PDVF membrane can capture PSA which is secreted by LNCaP cells, as 

shown in Figure 32. When the LNCaP cells were stimulated with R1881, most of the PSA secretion 

spots become bigger. When the cells were AR inhibited using Enzalutamide the PSA secretion 

spots become smaller.  

 

Figure 32: Membranes with captured PSA from LNCaP cells under different conditions after 24 hour. Upon androgen 
stimulation with R1881 more and bigger PSA spots are identified. After treatment with Enzalutamide smaller dimmer PSA 
spots are identified.  A) Captured PSA of 2000 untreated LNCaP cells. b) Captured PSA of 2000 cells LNCaP cells which are 
stimulated with R1881 [0.5nM] for 24 hour. C) Captured PSA of 2000 LNCaP cells after 24 hour treatment with 
Enzalutamide [2 µM]. Before the 24 hour Enzalutamide treatment, the LNCaP cells were overnight stimulated with R1881 
[0.5 nM]. Passage number = 41. 

Figure 31: Detected spots of seeded HEPG2 cells and empty membranes after 24 hour. For HEPG N=3, for empty membrane 
N=1. Students t-test was performed to confirm significance. 
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Single cell PSA secretion 

The values for PSA (mean intensity spot * area spot) secreted by individual LNCaP cells after 24 

and 48 hours are shown in a scatterplot in Figure 33. The repeated experiments are shown in the 

graph. The assumption is that each spot on the membrane belongs to a single cell. It is not possible 

to confirm this, because there is no image of the cells on the membrane, with which to correlate 

the spots. 

 

Wide variation in PSA secretion 

There is a wide variation in the amount of PSA that each cell secretes as shown in Figure 33. This 

corresponds to the images of the membranes (Figure 27). Both small dim dots and bigger brighter 

dots were visible on the membrane, indicating a high variation in PSA secretion per cell. This can 

be due to heterogeneity, some cells secrete more PSA than others. Other studies showed also 

heterogeneity in PSA secretion from LNCaP cells (Abali et al., 2021). In addition, it is not sure if 

each spot is derived from a single cell. It can be that multiple cells were clustered and their 

secreted PSA is at the same location on the membrane.  

It should also be noted that despite the well-considered choice of the intensity threshold, some 

spots were merged. This resulted in one spot with a larger area instead of multiple smaller spots. 

This may result in higher values. 

Influence of androgen activation and inhibition 

The results indicated that androgen stimulation leads to an increase in PSA secretion compared 

to the untreated cells (one exception: third experiment, 24 hour timepoint), as seen in Figure 33. 

After treatment with enzalutamide, a decrease in PSA secretion was observed, compared to the 

androgen stimulated cells. In most experiments, the amount of PSA secreted after treatment with 

enzalutamide, was also lower compared to the untreated cells (two exceptions, second 

experiment (N=2), both after 24 and 48 hours). 

Figure 33: Detected PSA secretion of single LNCaP cells after 24hour and 48hour under different conditions. The black line 
represents the mean. In general higher PSA values are observed after androgen stimulation (R1881), and lower PSA values 
are observed after treatment with Enzalutamide. Data was normalized to the HEPG2 cell line. Students t-test was performed 
to confirm significance. * 0.05 < P;     **0.01< P;  ***0.001< P 
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The exceptions can be attributed to multiple factors such as the passage number, the confluency 

or the different cell cycle stages of the cells. Heterogeneity can also be a reason for the variation 

in trends. It can be that not all cells are affected by Enzalutamide or require a higher drug 

concentration. 

The increase in PSA secretion after androgen stimulation and decrease in PSA secretion after 

treatment with anti-androgens is in line with what is found in the literature. C.S. Mathy et al. 

reported that the anti-androgen abiraterone induces a concentration-dependent decrease in PSA 

secretion (Mathy et al., 2021).  In addition, F. Abali et all. showed increased PSA secretion upon 

androgen stimulation and decreased PSA secretion when LNCaP cells were treated with the anti-

androgens enzalutamide and abiraterone (Abali et al., 2021). 

 

24 hour versus 48 hour 

It was expected that more PSA secretion was detected after 48 hours compared to 24 hours 

because cells have more time to produce and secrete PSA. However, no differences in trends of 

PSA secretion were observed between the timepoints 24 and 48 hours (Figure 22). It could be 

that the cells require more stimulation over time, or that the cells reach saturation of PSA secretion. 

Another possible explanation is that there was a difference in PSA secretion between the 

timepoints, but that this technique is not sensitive enough to visualize it on the membranes. 

 

Percentages of PSA secreting cells 

2000 cells were seeded on the membrane but not more than 400 spots were detected on the 

membranes. This indicates that not all cells secrete PSA. Approximately 7% of the untreated cells 

secrete PSA. The study of F. Abali et all. showed that 53% of viable LNCaP cells secrete PSA 

(Abali et al., 2021). However, the method differs in several important ways. In the study of F. Abali 

the exact amount of live LNCaP cells was known. In our research is the exact amount of living 

LNCaP cells not known. In addition, it is not known if a secretion spot belongs to one or multiple 

cells. 

The percentages of PSA secreting cells are presented in Figure 34. 

After 24 hours, it was observed that 

with stimulation, the number of PSA 

secreting LNCaP cells was increased 

by 2.2 %. While after AR inhibition, a 

small decrease of PSA secreting 

LNCaP cells (0.4%) was observed 

(Figure 34). After 48 hours, there was 

also an increase in PSA secreting cells 

after androgen stimulation (2.7%), 

however, no decrease in the number of 

PSA secreting cells was seen after 

treatment with Enzalutamide 

compared to the untreated cells. The 

AR inhibited condition did show a decrease in PSA secreting cells compared to the androgen 

stimulated condition (1.8%).  

Figure 34: Percentages of PSA secreting LNCaP cells after 24 and 48 
hour upon androgen stimulation and inhibition. Data represents 
mean ± sd (n=3). Students t-test was performed to confirm 
significance. Passage numbers of LNCaP cells were 41, 42 and 43. 



38 
 

Summarized, the results indicate that a higher number of LNCaP cells secrete PSA after androgen 

stimulation. However, these results have a high standard error and are not significant. This can be 

attributed to the fact that fewer secretion spots were detected for the experiment repeated for the 

third time (N=3). However, the cells were treated the same as in the previous experiments and 

showed healthy morphology.  

There are some drawbacks to our method which result that the percentages of PSA secreting 

LNCaP cells are not fully reliable. First of all, it can be that cells are clustered together, which 

results in one big PSA secretion spot on the membrane instead of multiple smaller spots. This 

reduces the number of detected PSA spots. In addition, there is mentioned that 2000 cells were 

seeded on the membrane. However, this is with a large error. This is because the cells were 

counted with the luna counter, which is not the most reliable method to count cells. In addition, 

only 2000 cells were needed from a cell suspension of approximately 2,5 million cells. This means 

that only a really small volume was needed from a bigger volume. It is a rough estimation that 

2000 cells are in the small volume that is taken. In addition, the cell suspension was added to a 

square membrane in a round well plate. As a result, cells were also able to attach to the bottom 

of the well plate next to the membrane instead of on the membrane. 

However, the method was consistently used for analysing every membrane and hence, is 

comparable for all cell lines of different time points and conditions.  

 

Total PSA secretion 

Next, the total amount of PSA that is secreted by 2000 LNCaP cells was calculated by adding the 

PSA values of all individual cells. This data is presented in Figure 35. The graph implicates that 

the androgen stimulated cells secreted in total a higher amount of PSA, while in comparison, the 

inhibited cells secreted in total less PSA.  

In addition, it was observed that the decrease in PSA secretion of inhibited cells was more in 24 

hours than in 48 hours. A possible explanation is the loss of the inhibitory function of the drug after 

24 hours.   

The trend of increase in PSA secretion after androgen stimulation and decrease in PSA secretion 

after treatment with anti-androgens is in accordance with the literature (Mathy et al., 2021)(Abali 

et al., 2021) 

LNCaP is a hormone-sensitive cell 

line. PSA secretion of LNCaP cells is 

affected by the anti-androgen 

enzalutamide. Enzalutamide is also 

used for the treatment of mHSPC 

patients. These results suggest that 

LNCaP cells can be used as a good 

model for mimicking the PSA 

secretion response to anti-

androgens in mHSPC patients.  

 

 
Figure 35: Total amount of PSA secreted by LNCaP cells upon androgen 
activation and inhibition after 24 and 48 hour. Data represents min to max 
with mean (n=3.) Passage numbers of LNCaP cells were 41, 42 and 43. 
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3.3.2.3 Other prostate cancer cell lines 

PSA secretion 

The detected PSA spots, secreted by single cells of different PCa cell lines, are presented in Figure 

36 (N=3). Only a few spots were detected in each cell line. In addition, there was not a clear trend 

between the conditions (untreated, androgen stimulated and AR inhibited) and also between the 

different cell lines. Graphs with more details of the individual cell line are presented in the 

Supplementary Data (Supplementary Figures 15-19). 

 

The main limitation of this method, to detect PSA secretion from single cells on membranes, is 

that it is not possible to distinguish between PSA secretion and unspecific binding or artifacts on 

the membrane. From PC-3 cells is well known that they do not secrete PSA. However, some PSA 

spots were detected on the membranes of PC-3 cells. This is probably not PSA secretion. From 

22Rv1 is known that it secretes PSA, this was also detected in the supernatant. However, the 

number of detected spots and the PSA value of these spots on the membrane of 22Rv1 cells, 

were comparable to the detected spots on the membrane of the PC-3 cell line. It is difficult to 

determine if the spots, developed by 22Rv1 and the other cell lines, are true PSA secretions.  

A microwell chip should be used to overcome this problem and to be able to conclude what is a 

PSA secretion spot and what is not. Using this chip, the secretion spots on the membrane can be 

correlated with the cells in the chip. To confirm if a spot is protein secretion, the corresponding 

well with the cell can be evaluated. The presence of a cell in the microwell can confirm the 

possibility of secretion otherwise, it can be regarded as unspecific staining or artifacts on the 

membranes.   

In addition, spots on the membrane were missed due to a too low intensity value. Using the 

microwell chip it can be determined if these spots are protein secretion. If these spots are protein 

secretions, adjustments in the quantification protocol must be made to include these spots.  

PSA secretion versus intracellular PSA 

Intracellular PSA was observed in LNCaP cells, androgen stimulated RWPE-2 cells and in a low 

amount in 22Rv1 cells. It is difficult to identify if the intracellular PSA is in line with the PSA secretion 

of the cell lines RWPE-2 and 22RV1, as this method (Section 2.5.2) fails to distinguish between 

PSA secretion and artefacts. 

 

Figure 36: Detected PSA secretion of single PCa cells after 24 and 48 hour under different conditions. The black line represents 
the mean. No clear trend was observed. Data was normalized to the HEPG2 cell line. Students t-test was performed to 
confirm significance. * 0.05 < P;     **0.01< P;  ***0.001< P (N=3, data is combined) 
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Percentages of PSA secreting cells 

The percentages of PSA secreting cells after 24 hours and 48 hours are shown in Figure 37. The 

percentages of PSA secreting cells were very low. There was no trend between the different 

conditions. In addition, there was no significant difference within different conditions. The 

percentages of PSA secreting cells of the PCa cell lines are comparable to the negative control 

cell line HEPG2. There is need for a reliable method which can distinguish between PSA secretion 

and artifacts. 

 

 

Overview 

An overview of the PSA secretion for each cell line is presented in Table 8. 

Table 8: Overview: PSA secretion by different PCa cell lines. 

 

The advantage of this method, using a PVDF membrane, is that PSA secretions from single cells 

can be detected and quantified. Apart from PSA, other proteins of interest can also be analysed 

to assess the effect of drugs on different cell lines. However, the seeded cells can not be directly 

Disease 

state 

Cell line Relative mean PSA per cell % secreting cells 
-R1881 +R1881 + Enzalutamide -R1881 +R1881 + Enzalutamide 

B
e

n
ig

n
 

PWR-E1 24hr 

               48hr 

0 

2.5*107 

2*107 

1.8*107 

0.4*107 

1.4*107 

0% 

0.03% 

0.03% 

0.01% 

0.1% 

0.02% 

RWPE-1 24 hr 

               48hr 

0 

0.4*107 

1.3*107 

2.2*107 

9.1*107 

4.7*107 

0% 

0.03% 

0.08% 

0.1% 

0.05% 

0.02% 

H
S

 

RWPE-2 24hr 

               48hr 

0.8*107 

1.6*107 

0 

1.1*107 

5.2*107 

0.8*107 

0.02% 

0.05% 

0% 

0.08% 

0.07% 

0.03% 

LNCaP   24hr 

               48hr 
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Figure 37: Percentages of PSA secreting cells after 24 and 48 hour upon androgen stimulation and inhibition. No clear trend 
was observed. Data represents mean ± sd (n=3). 
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correlated to their secretions. Using a microwell chip, secretion spots can be correlated to the 

cells located in each microwell. This is a potential platform to perform single cell proteomic 

analysis, isolate cells of interest and perform further downstream analysis to look into the possible 

phenotypic and genotypic heterogeneity within treated cells. 
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3.3.3 Enzyme-linked immunosorbent assay 

Enzyme-linked immunosorbent assay (ELISA) was performed to quantify the secreted PSA by the 

different PCa cell lines. In Figure 38 the amount of PSA secreted by different PCa cell lines after 7 

days of culturing in the T25 flask is shown. Three supernatant samples of the EMC-PCa-41 

organoid cell line are presented. These samples were stored one week, two weeks and six weeks 

after thawing the organoid cell line. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hormone-sensitive cell line LNCaP showed the highest PSA secretion levels (19600 ng/ml). In 

addition, PSA secretion of castration-resistant 22Rv1 cell line (200 ng/ml) and the castration-

resistant organoid cell line EMC-PCA-41(119 ng/ml, 83 ng/ml, 22 ng/ml) was detected.  

Remarkably, the PSA secreted by EMC-PCa-41 cells decreases with time. This could be due to 

fewer healthy living cells in the wells plate after the repetitive medium change, which can bring 

down the PSA production. Four weeks after thawing, the organoid cells were passaged. This could 

also result in loss of cells and so less cells which can secrete PSA. 

These findings are in line with the results of spotting supernatant on the membrane. The highest 

PSA concentration was found in the supernatant of LNCaP cells and a lower amount of PSA in the 

supernatant of 22Rv1 and EMC-PCa-41 cells.  

F. Abali et al. detected around 5 pg PSA per LNCaP cell per day (Abali et al., 2021). This is in line 

with the findings of our study. Assuming 500.000 cells per ml, around 5.6 pg PSA per LNCaP cell 

per day was expected in our study(19.600ng/ml /7 days /500.000 cells *1000). 

Literature showed also contradictory findings. S. Bhamre et al., detected 252 ng PSA per 1*106 

LNCaP cells after 24 hours (Bhamre, Whitin, & Cohen, 2003). Assuming 500.000 cells per ml, 

around 5600 ng PSA per 1*106 LNCaP cells after 24 hours was expected in our study.  

Figure 38:  PSA in the supernatant of different PCa cell lines. The supernatant is stored after seven days. 
PSA is detected in supernatant of LNCaP, 22Rv1 and EMC-PCa-41 cells. *One week after thawing ** Two 
weeks after thawing ***Six weeks after thawing 
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In addition,  T. Yamamoto et al. detected around 6 ng PSA per ml after 48 hours of culturing 

(Yamamoto et al., 2020) using ELISA. However, T. Yamamoto et al. did not mention the number 

of cells, which makes it hard to compare the data. These findings have lower PSA secretion levels 

than our findings. 

These contradictory results may be due to some limitations of this experiment. The ELISA was 

only performed once. The experiments must be repeated to confirm the findings. In addition, there 

was no optimized protocol for the ELISA with our cell lines and PSA as proteins of interest. Based 

on other studies, the concentrations for a calibration curve and dilution factors for supernatant of 

the cell lines were chosen. However, the PSA concentrations in the LNCaP, 22Rv1 and EMC-

PCa,41 cell supernatants did not fell within the linear portion of the standard curve (0–60 ng PSA). 

For a next experiment, other dilution factors are recommended, which are presented in Table 9. 

When the PSA concentrations from all cell lines fall within the linear portion of the standard curve, 

the quantitative results will be more reliable. 

Table 9: Recommended dilution factors for samples ELISA 

Cell line Condition Dilution factor 

LNCaP Supernatant collected after 7 days. On day 7 a 80% 

confluency. T25 flask. 

500x 

LNCaP 100.000 cells seeded in 24-wells plate Supernatant 

collected after 48hour. 

500x 

LNCaP 100.000 cells seeded in 24-wells plate. Stimulated with 

R1881. Supernatant collected after 48hour. 

800x 

22Rv1 Supernatant collected after 7 days. On day 7 a 80% 

confluency. T25 flask. 

5x 

22Rv1 100.000 cells seeded in 24-wells plate. Supernatant 

collected after 48hour. 

5x 

22Rv1 100.000 cells seeded in 24-wells plate. Stimulated with 

R1881. Supernatant collected after 48hour. 

5x 

EMC-PCa-41 Cells seeded in Matrigel. Supernatant collected after 48 

hours. 

2x 

 

Remarkable is that a low amount of PSA was observed in the PC-3 cell line. From PC-3 cells is 

known that they do not secrete PSA (Tai et al., 2011)(Yamamoto et al., 2020) and in our dot blot 

assay also no PSA was detected in supernatant of PC-3 cells. In addition, in another ELISA 

experiment, no PSA was detected in the supernatant of PC-3 cells (Figure 39). The detected PSA 

in this experiment (Figure 38) is probably due to artefacts. 

No PSA was detected in the supernatant of the other cell lines. This corresponds to the results of 

the dot blot assay. 

Influence of androgen stimulation on PSA secretion 

In another experiment, 100.000 cells were seeded in a 24-wells plate. Half of the cells were 

untreated and the other half were androgen stimulated using R1881. The supernatant was stored 

after 48 hours and an ELISA was performed. The results are shown in Figure 39.   

The untreated LNCaP cell secreted around 6787 ng PSA per 100.000 cells per 48 hours (33 pg 

PSA per cell per day) and the androgen stimulated LNCaP cells secreted around 17885 ng PSA 

per 100.000 cells per 48 hours (90 pg PSA per cell per day). Androgen stimulation had a 

significant increasing influence on the PSA secretion of the hormone-sensitive LNCaP cell line. In 
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the results of Section 3.3.2.2 also an increase in PSA secretion by LNCaP cells after androgen 

stimulation was detected. Unfortunately, we don’t have exa t values of these experiments. 

Therefore we can not compare the amount of PSA secreted with the single cell membrane 

experiment. 

Untreated 22Rv1 cells secreted around 75 ng PSA per 100.000 cells per 48 hours (0.37 pg PSA 

per cell per day). When the cells were androgen stimulated around 84 ng PSA per 100.000 cells 

per 48 hours (0.42 pg PSA per cell per day) is detected. This is a small increase, but not a 

significant difference. From the single 22Rv1 cells on a PVDF membrane (Section 3.3.2.3) was a 

negligible amount of PSA secretion detected and even no influence of R1881. 

ELISA must be repeated with the previously described adjustments and the influence of the anti-

androgen Enzalutamide should be included. 

  

Figure 39: Effects of R1881 on PSA secretion in different PCa cell lines. The data indicate a significant increasing effect in PSA 
secretion upon stimulation with R1881 for LNCaP cells. For 22Rv1 cells no significant difference in PSA production is 
observed.  
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3.4 Expression study of prostate cancer cell lines  
Using flow cytometry the expression of PSMA, HER2 and EpCAM was evaluated in different PCa 

lines and shown in Figure 40.  

PSMA 

The hormone-sensitive cell line LNCaP showed the highest expression for PSMA, as seen in Figure 

40a. It is seen that the castration-resistant 22Rv1 cell line also expresses PSMA, but in a lower 

amount compared to LNCaP cells. This is in line with the results of the immunofluorescence 

staining, as described in Section 3.1.  

In literature is stated that around 20-30% of 22Rv1 cells express PSMA and almost 100% of 

LNCaP cells express PSMA (Sheehan et al., 2022)(Staniszewska et al., 2021). This result in 

different levels of PSMA expression (low versus high), which is in accordance with our findings. 

However, it is known that PSMA is highly expressed in PCa and can be increased in castration-

resistant patients. Our results suggest higher PSMA expression for the hormone-sensitive cell line 

LNCaP, compared to the castration-resistant cell lines. This is probably due to the heterogeneity 

of PSMA expression (Sheehan et al., 2022). In addition, some PCa cell lines and patients lack 

PSMA expression, even castration-resistant cell lines.  

This experiment did not identified PSMA expression for the castration-resistant PC-3 cell line, the 

hormone-sensitive RWPE-2 cell line and the benign PWR-E1 and RWPE-1 cell lines. This is in 

accordance with the results of the immunofluorescence staining, as described in Section 3.1. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 40: PSMA, HER2 and EpCAM expression in different PCa cell lines. A) PSMA expression is observed by 
LNCaP and 22Rv1 cells. B) Her 2 expression is observed by LNCaP, 22Rv1 and PC-3 cells. c) EpCAM 
expression is observed by PWR-E1, RWPE-2, LNCaP and 22Rv1 cells.  Data represents the mean ± sd (n=2, 
exception for RWPE-1: n=1). 
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HER2 

Hormone-sensitive cell line LNCaP showed the highest HER2 expression, as seen in Figure 40b, 

compared to the castration-resistant and benign cell lines. The castration-resistant cell line PC-3 

showed also high HER2 expression, but there is a high variation between the different 

experiments. HER 2 expression is also detected in LNCaP and PC-3 cells in other studies 

(Malmberg, Tolmachev, & Orlova, 2011). In the other PCa cell lines low HER 2 expression was 

observed compared to LNCaP and PC-3 cells. 

In HER2 positive breast cancer patients, HER2 targeted therapy is already proven to be an 

effective treatment (Dent et al., 2013). Studies reported also overexpression of HER2 in PCa (Day 

et al., 2017) (Sharifi et al., 2016). Investigating HER2 expression in different PCa cell lines, with 

various aggressiveness, and their response to different treatments can be used for exploring the 

possibility of using HER 2 as a biomarker for PCa. 

 

EpCAM 

In all PCa cell lines EpCAM expression was identified, but at different levels, as shown in Figure 

40c. There is not a clear trend between benign, hormone-sensitive and castration-resistant cell 

lines. P. Massoner et al. observed EpCAM protein overexpression in PCa cell lines (LNCaP, PC-

3) compared to benign cell lines (RWPE-1) (Massoner et al., 2014). In other studies also EpCAM 

expression is detected in the PC-3 cell line (Czaplicka et al., 2020)(Xu, Zhao, & Hou, 2014). This 

is partly contradictory to our findings. We did identified EpCAM overexpression in the LNCaP cell 

line compared to RWPE-1, but we did not identify overexpression in the PC-3 cell line. The 

experiment must be repeated to confirm these contradictory findings. In addition, the high EpCAM 

expression in the benign PWR-E1 cell line is remarkable. However, no earlier research on EpCAM 

expression in PWR-E1 cells is performed. 

More data is required to establish EpCAM as prognostic biomarker or a potential EpCAM targeted 

therapy for PCa. 
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3.5 Overview data 
In this section, the results of this research are summarized in Table 10. 

 

 

 

 

 

 

 

 

  

Table 10: An overview of the results of all PCa cell lines. 
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4. Conclusion 
In this study, we aimed to develop a realistic model to study the phenotypic response of PCa cell 

lines towards stimulation and inhibition of the AR, to obtain more insight into different PCa cell 

lines. Different PCa cell lines were characterized based on intracellular PSA, PSA secretion and 

expression of PSMA, EPCAM and HER2. 

We detected PSA secretion from different malignant PCa cell lines (LNCaP, 22Rv1, EMC-PCa-

41) and observed absence of PSA secretion in the benign cell lines. The hormone-sensitive cell 

line LNCaP showed higher levels of PSA secretion compared to the castration-resistant cell lines. 

In addition, we identified an increase in PSA secretion upon androgen stimulation and a decrease 

in PSA secretion after treatment with the anti-androgen enzalutamide, in LNCaP cells. These 

results suggest that LNCaP cells can be used as a model mimicking the responses to anti-

androgens in mHSPC patients. 

In addition, we discovered that detecting single-cell PSA secretion from low producing cell lines, 

using a PVDF membrane, (method in Section 2.5) is difficult. A low amount of PSA secretion is 

hard to distinguish from unspecific staining. The use of PVDF membranes to capture secreted 

proteins show promise, however, this method must be improved to study the phenotypic response 

of single cells. 

Our findings indicate the presence of PSA secretion and PSMA, EpCAM, and HER2 expression in 

malignant PCa cell lines and the absence of PSA secretion and PSMA expression in benign cell 

lines. The hormone-sensitive cell line LNCaP shows higher levels of PSMA and HER2 expression 

compared to the benign and the castration-resistant cell lines.  

Taken together, LNCaP cells can serve as a good model to study PSA secretion in response to 

drugs, with the use of a PVDF membrane. In the future, a microwell chip can help to identify the 

effect of drugs and stimulation on PSA secretion from the other PCa cell lines.  
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5. Future recommendations 
In this chapter different limitations of our research and recommendations for future research are 

discussed. 

We optimised a model to study the phenotypic response of single cells of PCa cell lines towards 

stimulation and inhibition of the AR. The obtained results indicate that the method, single cell PSA 

secretion on membranes, is only useful for high-producing cell lines. The obtained results from 

low-producing cell lines are comparable to the negative control. This method fails to distinguish 

between PSA secretion and unspecific staining. 

To overcome this problem, a microwell chip can be used. Using this chip, the secretion spots on 

the membrane can be correlated with the cells in the chip. To confirm if a spot is actually protein 

secretion, the corresponding well with the cell can be evaluated. The presence of a cell in the 

microwell can confirm the possibility of secretion. Otherwise, it can be regarded as unspecific 

staining or artefacts on the membranes. The microwell chip was tested using LNCaP cells and the 

results are quite promising in detecting and correlating the secretions with single cells. 

Another advantage of using a microwell chip is that it shows the potential to identify the secretome 

from many cell lines. Different (stained) cell lines could be seeded simultaneously in the same chip 

and analysed for their protein secretion. This is time and cost-efficiently. In addition, using a 

microwell chip, the application multiplexing on membranes could be explored. The PVDF 

membranes can be coated with different coating antibodies, to simultaneously detect the 

secretion of different proteins. Another advantage of the microwell chip is that cells of interest can 

be punched out of the microwell chip and can be used for further research. This way the secretion 

level of a single cell can be correlated with other characteristics of the single cell, for example, 

their gene expression. 

 

A limitation that needs to be addressed in this project, is the quantification method. Further 

optimization is recommended to improve the current quantification method, which is based on the 

fluorescent intensity of the spot. A more optimized method could take into account the circularity 

and fading of a spot. PSA secretion spots from LNCaP cells on membranes are clear round spots, 

which fade at the edges. However, artifacts are shown as small round spots with sharp edges, or 

as spots with an odd shape. Taking circularity and fading into account, could improve the 

quantification method to distinguish between spots and unspecific staining. 

Another limitation that needs to be addressed is the lack of a standard curve. To make the PSA 

secretion data quantitative, a reliable calibration curve is needed. This experiment should be 

repeated with the previously described PSA concentrations. The exact quantitative data can then 

be compared with the literature and the results of the ELISA. The ELISA must also be repeated 

with the recommended dilution factors for supernatant of the cell lines. This will result in more 

reliable quantitative values. In addition, in a next ELISA experiment, both the PSA concentration 

of the supernatant of the cell lines as the PSA concentration of lysed cells can be explored. This 

way the difference between secreted PSA concentrations and cellular PSA concentrations can be 

determined. 

This research fails to culture patient-derived organoids EMC-PCa-41. Due to the difficulties in 

growing the EMC-PCa-41 organoid cells, these cells could not be characterized and assessed for 

their responses to treatment. It is known that the success rate for obtaining and culturing patient-

derived organoids from PCa patients is very low (Mout et al., 2021)(CHEAITO et al., 2022). The 

organoid cell line EMC-PCa-41 was kindly provided by Erasmus. More guidance from Erasmus in 
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culturing this organoid cell line would be beneficial. Culturing with some of the established PCa 

organoid cell lines such as MSK-PCa-1 and MSK-PCa2 can be utilized to develop preliminary 

models. Following this, culturing and characterization of EMC-PCa-41 can be performed to check 

for PSA and PSMA protein, secretion of PSA and the influence of anti-androgens such as 

Enzalutamide and other clinically relevant drugs such as Abiraterone and Docetaxel.  

Another recommendation for future research is to explore other interesting secretome biomarkers 

in PCa. Such as the AR, prostate-specific cytokines and cathepsins K. In addition, the gene 

expression of different cell lines after stimulation and inhibition of the AR can be evaluated to 

provide a better understanding of the effect of treatment on these cell lines and determine possible 

correlation with the proteomic analysis. Together genotypic and proteomic analysis of single cells 

can help in identify prognostic biomarkers and develop an effective and personalized treatment 

for prostate cancer patients. 
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Supplementary data 
 

Calibration curve 
The calibration curve is shown in Supplementary Figure 1. Low PSA concentrations resulted in 

dots with speckles (Supplementary Figure 2 and 3) and the highest PSA concentrations appeared 

saturated in the calibration curve (the two rightmost points in Supplementary Figure 1). This 

resulted in a low R-value (0.7066). Dismissing the two rightmost points, resulted in four points with 

a linear trendline, with a high R-value (0.9749)(trendline not shown). However, the quantitative 

data resulting from both trendlines in the calibration curve was not in line with the quantitative data 

of the ELISA and literature. Therefore, relative data will be used in the PSA secretion experiments. 

In future studies, it is recommended to repeat the experiment, to create a calibration curve, with 

the following PSA concentrations of 0 to 300 µg/mL in a serial dilution. 

The area obtained from Image J was given in pixels. The formula to calculate the area in µm2 is:  

Area (µm2) = ((area (pixel)/16)*0.65)2. In next experiments, the known size of a pixel should be 

filled in in the settings of the Image J software, as seen in: recommendation to quantification 

protocol in the Supplementary Data.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Supplementary Figure 2: PSA dilution spots with a PSA 
concentration of 2.3 µg/mL. 

Supplementary Figure 3: PSA dilution spots with a PSA 
concentration of 0.6 µg/mL. 

                   
           

 

    

    

    

    

    

    

    

    

                             

 
  
 
   
  
 
  
  
  
 
 
  
 

            

                

Supplementary Figure 1: Calibration curve PSA dilutions 
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Overview characteristics datasets 
Due to a change in microscopic fibre during the experiments, there is a change in exposure time 

and intensity threshold. These changes are presented in Supplementary Table 1. 

Supplementary Table 1: Properties different dataset PSA secretion 

 

 

 

 

 

 

 

 

 

 

 

 

  

Dataset Cell line Fiber type Exposure time Intensity 

threshold 

04-02 RWPE-1, 

LNCaP, 22Rv1, 

PC-3, HEPG2 

Old 50 ms 550 

10-02 PWR-E1, RWPE-

1, RWPE-2, 

LNCaP, 22Rv1, 

PC-3, HEPG2 

Old 50 ms 550 

18-02 PWR-E1, RWPE-

1, RWPE-2, 

LNCaP, 22Rv1, 

PC-3, HEPG2 

New 20 ms 5500 

05-04 PWR-E1, RWPE-

2, HEPG2, 

empty 

membrane 

New 20 ms 5500 
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Quantification method 
 

1. Create montage from individual images in image J: 

a. Drag the folder with individual images to the software Image J. 

b. The following pop-up appears (Supplementary Figure 4). Choose: ‘Use virtual 

sta k’. 

c. Go to: Image → Stacks → Make 

montage 

d. Save montage as tiff file: File → Save as 

 

 

 

 

2. Duplicate the montage and adjust it 

a. Go to: Image → Duplicate 

b. Adjust the brightness of the image, go to: Image → Adjust → Brightness and 

contrast 

c. Click on Set: the following pop-up appears (Supplementary Figure 5). Fill the 

following values in and press OK. 

i. Minimum displayed value: 0 

ii. Maximum displayed value: 1023 

iii. Unsigned 16-bit range: 10-bit 

d. Click on Apply in the ‘Brightness and  ontrast’ pop-up. 

 

 

 

 

 

 

 

 

 

 Supplementary Figure 5: Set display range 

Supplementary Figure 4: Open Folder 
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3. Set an intensity threshold 

a. Click on the duplicated 10-bit image 

b. Go to: Image → Adjust → Threshold 

c. The following pop-up appears (Supplementary Figure 6) 

d. Choose an intensity threshold value by dragging the bar or filling in exact numbers. 

In this case, a minimum intensity threshold of 550 is set. 

e. Press: Apply. A binary image is created. 

 

 

 

 

 

 

 

 

 

 

 

4. Set measurements 

a. Go to: Analyze → Set Measurements 

b. The following pop-up appears 

(Supplementary Figure 7). Choose the 

factors which you want to measure. 

c. Redirect to the original image (not the 

binary image). 

d. Press: OK. 

 

 

 

 

 

 

 

Supplementary Figure 6: Choose an intensity  
threshold 

Supplementary Figure 7: Set Measurements 
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5. Analyse particles 

a. Go to: Analyze → Analyze Particles 

b. The following pop-up appears (Supplementary Figure 8). Choose the 

minimum/maximum pixel size. 

i. LNCaP cells: 4-infinity 

ii. Other cell lines: 0-infinity 

c. Circularity: 0-1  

d. Show: Outlines  

e. Choose: Display results, clear 

results, exclude on edges, include 

holes 

f. Press: OK. A pop-up with the 

results appears. 

 

 

 

 

6. Process data 

a. Copy the data to excel 

b. Measure the mean intensity of the belonging membrane with HEPG2 cells and 

subtract this mean intensity from all individual spot mean intensities. 

c. Multiply the individual mean intensities by the area. This result in a value which 

says something about the amount of PSA that is secreted.  

d. Calculate these values for the negative control: HEPG2. Calculate the mean value 

of the spots of HEPG2 cells. Take only values into account with a value higher than 

the mean value of the spots of HEPG2 cells. Plot these values. 

e. In case there exists a reliable calibration curve, use the formula from the linear 

trend-line:  

i. pg/µm2 = (Mean intensity/a)-b 

1. Mean intensity of the spots is known. 

2.  (a and b are obtained from the formula of the calibration curve). 

ii. Multiply the  al ulated ‘pg/µm2’ by the size of the spot (in µm2) 

Supplementary Figure 8: Analyze Particles 
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iii. This results in the amount of PSA in pg of one spot. 

Recommendations protocol 

- Set scale. Go to: Analyze → Set scale.  

- It is known that when using an objective of 10x, 1 pixel 

equals 0.65 µm. Fill this in (Supplementary Figure 9). 

 

 

 

 

 

 

Immunofluorescence staining on HEPG2 cells 
In Supplementary Figure 10 the immunofluorescence images of HEPG2 cells are shown. However, 

no specific PSA and PSMA is observed. 

Supplementary Figure 10: Immunofluorescence detection of both PSA and PSMA expression in HEPG2 cells following 
androgen stimulation (R1881) or Enzalutamide treatment. Cell nuclei were counterstained with DAPI (blue). A,b,c) 
Untreated HEPG2 cells. d,e,f) Androgen stimulated (R1881) HEPG2 cells. F,h,i) Enzalutamide treated HEPG2 cells. Specific 
fluorescence signals for PSA (green) were not detected outside the nuclei.  No signals for PSMA were detected in HEPG-2 
cells (not shown). Scale bar: 50 µm 

Supplementary Figure 9: Set scale. 
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Intensity difference individual image 
A membrane with spotted supernatant of LNCaP cells is shown in Supplementary Figure 11a. 

Vertical black lines in the spots are observed. From the pixels yellow line, the gray values are 

plotted and presented in Supplementary Figure 11b. A difference in gray value is observed in each 

individual image. 

 

 

 

Negative control spots medium EMC-PCa-41 
Dim spots of spotted medium of EMC-PCa-41 cells are shown in Supplementary Figure 12. The 

spots are indicated with red arrows. 

 

 

 

 

 

 

 

 

a b

Supplementary Figure 11: Difference in intensity in each individual image 

Supplementary Figure 12: Dim spots of medium EMC-PCa-41. 
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Threshold considerations 
In Supplementary Figure 13 a membrane of 22Rv1 cells is shown in which a threshold of 550 is 

set. The red dots with a blue circle are taken into account as a PSA secretion spot with this 

threshold. However the white spots without a blue circle are not taken into account as PSA 

secretion with this threshold. Upon decreasing the intensity threshold, so that also these spots are 

taken into account, it turns out that also a lot of background signal is detected (Supplementary 

Figure 14). This is not favourable and reliable. Therefor is decided to keep the threshold of 550. 

 

 

 

 

 

 

 

 

 

  

Supplementary Figure 14: Intensity threshold of 280 units on membrane of 22Rv1 cells. Red spots are taken into 
account as PSA secretion spots. 

Supplementary Figure 13: Intensity threshold of 550 units on membrane of 22Rv1 cells. Red spots red dots with a blue circle 
are taken into account as PSA secretion spots. The white spots without a blue circle are not taken into account as PSA 
secretion.  
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Graphs PSA secretion single cells 
In Figure 36 an overview of PSA secretion of the different PCa cell lines is shown. In these 

Supplementary Figures 15-19, the PSA secretion graphs of the individual cell lines are shown. 

For the cell lines: PWR-E1 and RWPE-2 applies N=1 (dataset 10-2), N=2 (dataset 18-02), N=3 

(dataset 5-4). For the cell lines RWPE-1, 22Rv1 and PC-3 applies N=1 (dataset 4-2), N=2 (dataset 

10-02) and N=3 (dataset 18-02). 

 

 

 

Supplementary Figure 15: Detected PSA secretion of single PWR-E1 cells after 24 and 48 hour under different conditions. The 
black line represents the mean. No clear trend was observed. Data was normalized to the HEPG2 cell line.  

Supplementary Figure 17: Detected PSA secretion of single RWPE-2 cells after 24 and 48 hour under different conditions. The 
black line represents the mean. No clear trend was observed. Data was normalized to the HEPG2 cell line. 

Supplementary Figure 16: Detected PSA secretion of single RWPE-1 cells after 24 and 48 hour under different conditions. The 
black line represents the mean. No clear trend was observed. Data was normalized to the HEPG2 cell line. 
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Supplementary Figure 18: Detected PSA secretion of single 22Rv1 cells after 24 and 48 hour under different conditions. The 
black line represents the mean. No clear trend was observed. Data was normalized to the HEPG2 cell line. 

Supplementary Figure 19: Detected PSA secretion of single PC-3 cells after 24 and 48 hour under different conditions. The 
black line represents the mean. No clear trend was observed. Data was normalized to the HEPG2 cell line. 


